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Chapter 1
Introduction

This chapter contains a description of the main features, 
delivery options and software applications provided with 
the TDS800.
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About this manual

This manual contains the following chapters:

Chapter 1: Introduction  contains a general introduction to the Océ TDS800 
system, including a general description of the main features, delivery options 
and software applications provided with the system. Contains a description of 
how to turn on and off the Océ TDS800.

Chapter 2: Using the Océ TDS800 to print  contains a description of the 
actions that can be performed on the printer operator panel of the Océ TDS800.

Chapter 3 Using the Océ TDS800 to copy  contains a description of the actions 
that can be performed on the scanner operator panel of the Océ TDS800 
including the basic copy functions that are available from the system.

Chapter 4: Using the Océ TDS800 to scan  contains a description of how to 
scan originals to a file.

Chapter 5: Special copy and scan jobs  contains a detailed description of 
special copy functions to be performed on the Océ TDS800.

Chapter 6: Océ Power Logic®: Settings Editor  contains information about the 
Océ Settings Editor. For details about specific settings, refer to the Help on the 
Océ Settings Editor.

Chapter 7: Océ Power Logic®: System Control Panel  contains a description 
of how to view the system status of the Océ TDS800.

Chapter 8: Océ Power Logic®: Queue Manager  contains a description of how 
to view the Océ TDS800 print queue and how to abort an active print, how to 
delete and pause print jobs in the queue and how to restart jobs that are put on 
hold.

Chapter 8: Océ Power Logic®: Remote Logic  contains a description of the 
installation and the function of the Océ TDS800 remote controller 
applications.

Chapter 10: Océ Account Center  contains a description of how to manage the 
account information of the print, copy and scan-to-file jobs with Océ Account 
Logic and Océ Account Console.
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Chapter 11: The folder  contains a description of the folder delivered as an 
option with the Océ TDS800.

Chapter 12: Media and supplies  contains a description of regular maintenance 
tasks, like loading paper, adding toner, and changing tape in the reinforcement 
unit.

Chapter 13: Maintenance  contains a description of how to clean the glass 
platen, the reference roller and how to maintain the reinforcement unit.

Chapter 14: Problem solving  contains a description of the problems that may 
occur while using the Océ TDS800.

Appendix A: Overview and tables  contains an overview of the system, the 
operator panels, the product specifications for the Océ TDS800, a list of 
available material types and sizes, and a list of formats included in the paper 
series.

Appendix B: Safety information  contains the recommended weight limits, 
instructions for safe use, the available safety data sheets and the applicable 
ENERGY STAR® specifications.

Appendix C: Miscellaneous  contains the notation conventions, a reader’s 
comment sheet and the addresses of local Océ organizations.

Index  indicates where you can find the most commonly-used terms in the 
manual.
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The Océ TDS800

The Océ TDS800 is a wide format, black and white, high volume 
multifunctional system. The Océ TDS800 offers a broad range of print, copy, 
and scan-to-file functions. The printer prints at a resolution of 400 dpi and is 
highly productive because of its Océ Copy Press technology. See ‘Product 
specifications Océ TDS800’ on page 245 for more information.

[1] Océ TDS800
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Océ TDS800 key concepts

Printer configuration  The Océ TDS800 has six media rolls, a roll loader and a 
horizontal delivery tray. A folder is optional.

Copy function  With the Océ TDS800 scanner a large number of copy 
activities can be performed. A wide variety of original and copy related 
settings are supported. Users can specify particular layout, media, finishing, 
feeding and quality enhancement options from the scanner operator panel. See 
‘Product specifications Océ TDS800’ on page 245 and ‘Scanner operator 
panel’ on page 244 for more information.

Océ Scan Logic®  The Océ TDS800 offers full hybrid performance with it’s 
optional scan-to-file function. Documents are scanned then stored digitally. 
Ten customisable destinations are supported.

Adobe® PostScript® 3/PDF  The Océ TDS800 fully supports Adobe® 
PostScript® 3. For Japanese 5 extra fonts are optional. They can be enabled 
with a password in the Océ Settings Editor.

Network connectivity  The Océ TDS800 supports a number of popular network 
protocols. This means that it can be used in multiple networking environments 
such as TCP/IP, NetBEUI, and Novell Pserver (IPX/SPX).

Print and copy jobs  Print and copy jobs are sent to the Océ TDS800 Printer 
from a user application (print job) or from the scanner (copy job). Print and 
copy jobs can consist of several sets, which in turn can consist of several pages. 
Sorting of a print or copy job can take place based on sets or on pages.

Set processing  The Océ TDS800 supports set processing. This means that a 
job can consist of several files or originals. You can print or scan these files or 
originals multiple times and in sorted sets. The Océ TDS800 is equipped with 
2 hard disks with a set memory for storing up to 250 A0s each. This allows for 
the creation of identical sets that are sorted either by page or by set. See also 
‘Make a set copy’ on page 111.

Océ Matrix logic®  Océ Matrix Logic® is an Océ TDS800 option which allows 
you to form in one single operation different copy sets from one set of scanned 
originals using predefined settings. See ‘Océ Matrix Logic® introduction’ on 
page 112.
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Spool memory  The Océ TDS800 contains a spool memory which provides a 
queuing system for files you want to print. The spool memory allows multiple 
users to send print jobs to the Océ TDS800 at the same time. The print jobs are 
then placed in the print queue where they wait to be printed. The job that is put 
first into the queue is printed first.

Job recovery  The Océ TDS800 is equipped with a job recovery function that 
safeguards users against data loss in case of a printer failure. After a restart, the 
data submitted to the printer before the crash is automatically processed and 
printed. This means that jobs do not have to be re-submitted after a printer 
malfunction.This saves valuable time for the users.

Green key principle  The Océ TDS800 is a very user-friendly system. The 
scanner, in particular, is very easy to operate. Basic copy jobs can be performed 
by simply pressing the green start key on the scanner operator panel. Only if 
you want to perform more complex copy jobs, you have to change the default 
copy settings with the help of the other settings on the scanner operator panel.

User interaction

The user can communicate with the Océ TDS800 both local on the system and 
from remote locations:

Operator panels  The Océ TDS800 consists of two operator panels for making 
a wide variety of settings for printing and copying. See ‘Printer operator panel’ 
on page 243 and ‘Scanner operator panel’ on page 244 for more information.

Controller applications  The Océ TDS800 controller applications are used for 
making default key operator and system administrator settings (Océ Settings 
Editor). For viewing the status of the jobs in the print queue you use the Océ 
Queue Manager. The Océ System Control Panel shows the status of the entire 
system. 

Océ Scan logic®  With ‘Océ Scan logic®’ you can define all relevant settings 
for scan to file. See ‘Océ Scan Logic®’ on page 70 for more information.

Océ Remote Logic®  With Océ Remote Logic® you can perform the following 
actions from any PC connected to the network and with Océ Remote Logic® 
software installed:

■ Remotely view system status (Océ System Control Panel).
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■ Remotely manage print jobs (Océ Queue Manager).
■ Remotely change settings (Océ Settings Editor).

Printer drivers  With the Océ TDS800 a number of printer drivers can be used, 
including a Windows® raster driver, AutoCAD® HDI drivers and a 
PostScript® driver. With these drivers users in remote locations can print their 
files directly from their applications to the Océ TDS800. More information 
about installing, configuring and using drivers can be found in the 
documentation provided with the drivers. All Océ drivers can be freely 
downloaded from the Internet at www.oce.com.

Océ Print Exec® Workgroup  Océ Print Exec® Workgroup is optional software 
which allows you to create and send a set of files to the Océ TDS800. You can 
send jobs from your workstation, using your web browser. See also ‘Print with 
Océ Print Exec® Workgroup’ on page 40.

Océ Repro Desk  Océ Repro Desk is a print management solution for the 
reprographer and their clients. See also ‘Print with Océ Repro Desk’ on 
page 42.

Easy print submission through FTP  The Océ TDS800 supports printing via 
FTP. You can print files via FTP from a command line prompt, an FTP 
application, or from an Internet browser. The following Internet browsers 
support drag and drop of files:

■ Netscape® Navigator 4.x
Drag the jobs into the Jobs folder on the FTP site of your Océ TDS800. The 
jobs will appear in the print queue on the Océ Queue Manager.

The following Internet browsers support copy and paste of files:

■ Netscape® Navigator 4.x
■ Microsoft® Internet Explorer 5.5
Paste the jobs into the ‘Jobs’ folder on the FTP site of your Océ TDS800. The 
jobs appear in the print queue on the Océ Queue Manager.
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Océ TDS800 users

On the Océ TDS800 the following user types can be identified:

System administrator  The Océ TDS800 system administrator is responsible 
for installing and configuring the Océ TDS800 in its environment. He defines 
the printer language settings, pen settings and Automatic Language Sensing 
(ALS) settings. The system administrator can also provide assistance to normal 
users who need to install the printer drivers on their workstations. 
Configuration information can be found in the Océ TDS800 Connectivity 
Manual provided with the Océ TDS800.

Key operator  The Océ TDS800 key operator is responsible for the daily 
maintenance of the Océ TDS800. The key operator adds toner when necessary, 
loads media as needed and defines the default printer settings for recurring 
print jobs. Also, the key operator defines all time settings, such as panel time 
out and sleep mode time out. See ‘Océ Power Logic®: Settings Editor’ on 
page 125 for more information. 

Repro operator  The repro operator is responsible for the daily operations on 
the Océ TDS800. The Repro Operator settings are a subset of the Key Operator 
settings. The Repro Operator has no rights to change settings in the Océ Settings 
Editor. In the Océ Queue Manager and the Océ System Control Panel the repro 
operator has the same user rights as the Key Operator and System Administrator.

Anonymous user  Typically, an anonymous user on the Océ TDS800 can be 
either a PC user who has remote access to the system through one or more 
drivers (Windows® raster driver, AutoCAD® ADI/HDI drivers or PostScript® 
driver) or Océ Remote logic® (Océ Queue Manager, Océ System Control 
Panel and Océ Settings Editor), or a user performing a copy job at the scanner.

Service operator  The Océ TDS800 service operator is responsible for 
installation and maintenance of the Océ TDS800. 
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Océ TDS800 components

The Océ TDS800 is available as a digital network printer, or as a full 
combination with a scanner which can print, copy or scan to file. The Océ 
TDS800 consists of the following components (see Figure 1 on page 14):

■ Printer
■ Scanner
■ Océ Power Logic® Controller

These components, in combination with your network, Océ Print Exec® 
Workgroup and one or more drivers (Windows® driver, AutoCAD® HDI or 
PostScript®), allow you to use the Océ TDS800 as your default enterprise print 
and copy solution.

See the Connectivity Manual for more details about network settings for the 
Océ TDS800 printer. You find more information about installing, configuring 
and using drivers in the documentation provided with the drivers.

Note: All drivers for the Océ TDS800 can be freely downloaded from the World 
Wide Web at www.oce.com.

Océ TDS800 printer

The Océ TDS800 printer has the ability to contain six rolls of media. In 
standard configuration the printer delivers your jobs on the output delivery 
tray.

The Océ TDS800 printer has the following optionals:
■ a folder to fold the output.
■ a reinforcement unit to add a reinforcement strip.
■ a punch unit to make holes on one edge.
■ one or two belts to deliver folded output nicely stacked for a longer period of 

time (useful for unattended printing).
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Océ TDS800 scanner

You use the Océ TDS800 scanner to copy or to scan to file. 

The optional original delivery tray enables you to stack your originals behind 
the scanner.

Océ TDS800 Power Logic® Controller

The Océ TDS800 is equipped with a Océ Power Logic® Controller which 
helps you to make optimum use of your system. On this Océ Power Logic® 
Controller a number of applications run which allow you to control your jobs, 
make your default job settings and monitor the system status. These 
applications include:

■ Océ Queue Manager (QM)
■ Océ System Control Panel (SCP)
■ Océ Settings Editor (SE)
■ Océ Scan Manager and Océ View Station LT (optional)
■ Océ Remote Logic®, includes QM, SCP and SE on a remote workstation 

which connects to the Océ Power Logic® Controller. Océ Scan Manager and 
Océ View Station LT do not run on Océ Remote Logic®.

Océ Queue Manager  The Océ TDS800 Océ Queue Manager (QM) application 
provides you with a graphical representation of the print queue. It allows you 
to view the print queue and the status of the print and copy jobs as well as to 
manage the jobs in the queue. With the Océ Queue Manager you can:

■ View the print queue.
■ View the inbox queue
■ View the history queue
■ Abort the job currently being printed
■ Give jobs a priority in the print queue
■ Delete jobs in the print queue, inbox queue, and history queue
■ Pause jobs in the print queue
■ Restart previously paused jobs in the print queue
■ Print jobs from the inbox queue
■ Reprint jobs from the history queue
■ Change number of sets for jobs in the history queue
■ View the properties of jobs in the print queue, inbox queue, and history 

queue.
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See ‘Managing print jobs’ on page 153 for more information about the Océ 
Queue Manager.

Océ System Control Panel  The Océ System Control Panel (SCP) application 
provides you with status information about the printer. This includes:

■ Status of the Océ TDS800 printer and scanner
■ Set memory monitor to view the available storage space on the controller.
■ Overview of the loaded media types and sizes.

See ‘Océ Power Logic®: System Control Panel’ on page 141 for more 
information about the Océ TDS800 System Control Panel.

Océ Settings Editor  The Océ Settings Editor consists of 2 sets of settings, the 
key operator settings and the system administrator settings. 

The key operator settings allow the key operator to configure and set up job, 
printer, system and scanner specific settings. These settings include:

■ Format options
■ Editing options
■ Media related options
■ Finishing options

See ‘Océ Power Logic®: Settings Editor’ on page 125 for more information 
about the Océ TDS800 Settings Editor application.

The system administrator settings allow the system administrator to configure 
and set up all aspects related to the infrastructure of the system. These settings 
include:

■ Host information
■ Network settings
■ Pen settings
■ Printer language settings
■ General administrator settings

See ‘Océ Power Logic®: Settings Editor’ on page 125 for more information 
about the Océ TDS800 Settings Editor.
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Optionals:  you can order the following optionals for the Océ Power Logic® 
Controller:
■ Océ Scan Logic® consists of Océ Scan Manager and Océ View Station LT. 

With Océ Scan Logic® you can perform scan to file.
■ Océ Print Exec® Workgroup is a job submission application, which allows 

you to send print jobs to a destination device (Océ printer) from your web 
browser. For detailed information see ‘Print with Océ Print Exec® 
Workgroup’ on page 40.

■ Account Logging. Account Logging is for accounting purposes, the Océ 
Power Logic® Controller is able to keep track of all your jobs. For each job 
the job info and the paper usage is stored.

■ Job templates
The job templates on the scanner operator panel give you direct access to five 
different sets of settings. You define the template settings in the Settings 
Editor. You select a template on the scanner operator panel by pressing one 
of the five function keys. The fifth template includes the last used settings on 
the scanner.

■ Adobe® PostScript® 3™/PDF
■ 5 additional Japanese fonts for Adobe® PostScript® 3™
■ Océ Matrix Logic® 

Océ Matrix Logic® allows you to create, in one single operation, different 
copy sets from one set of scanned originals using predefined settings. See ‘Océ 
Matrix Logic® introduction’ on page 112.

■ Stamping
Stamping allows you to print a predefined text on all your copies (see 
‘Stamping’ on page 65).
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Turn on and off the Océ TDS800

You must separately turn on and off Océ TDS800 printer, scanner and the Océ 
Power Logic® Controller. You do not have to use a specific order in which you 
turn on and off the Océ TDS800 printer, scanner and the Océ Power Logic® 
Controller.

Use the key switch on the printer and scanner to turn on and off the printer and 
scanner. Use the On / off button on the Océ Power Logic® Controller to turn 
on and off the Océ Power Logic® Controller.

[2] Power switch with key in the timer position on the printer

[3] Power switch with key in the timer position on the scanner

on

off

timer

ontimer

off
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[4] Power button on the Océ Power Logic® Controller

▼ Turn the Océ TDS800 printer on and off

1 Turn the key to the ‘on’ position (see Figure 2).
The system takes about 20 minutes to warm up. When the system is warmed 
up, the message ‘Ready to...’ appears on the printer operator panel.

2 Turn the key to the ‘off’ position (see Figure 2).
Note: Before you turn off the printer, make sure that the printer is not 
printing a job.

▼ Turn the Océ TDS800 scanner on and off

1 Turn the key to the ‘on’ position (see Figure 3)
After a few seconds the message ‘Ready to print’ appears on the scanner 
operator panel.

2 Turn the key to the ‘off’ position (see Figure 3).

▼ Start up the Océ Power Logic Controller

1 Turn on the controller and the screen. 
After the initial system test of the controller the applications, Océ Queue 
Manager, Océ System Control Panel, Océ Settings Editor and Océ Scan 
Manager are automatically started and the controller applications are ready for 
operation.
Note: The Océ Settings Editor is minimised to save screen estate.

Take the following actions to turn off the controller:

▼ Turn off the Océ Power Logic® Controller

1 Go to the Océ System Control Panel application.
2 Select the ‘Shutdown’ option from the ‘System’ menu.
3 Confirm shutdown by clicking on the ‘Yes’ button in the ‘Shut down’ window.
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The system automatically performs the shutdown procedure for the controller. 
Finally, the Windows ‘Shutdown Computer’ window appears, which informs 
you that you can turn off your computer. 
You can now restart the controller by pressing the ‘Restart’ button.
Note: Wait at least 5 seconds before you restart the Océ TDS800.

4 Turn off your computer and display.

Timers

The Océ TDS800 is standard equipped with a number of timers for energy 
saving and automatic turn on and off behavior. The timers can be configured 
in Océ Settings editor. See Chapter 6, ‘Océ Power Logic®: Settings Editor’ on 
page 125 and the on-line help on the Océ Settings Editor for details. The Océ 
TDS800 has the following timers

■ Low power mode timer 
This timer only works for the printer. After the time defined in the Océ 
Settings Editor, the printer uses a little less power and cools down slightly.

Note: You can disable the Low power mode timer in the Océ Settings Editor 
(see ‘Find system settings in the Settings Editor’ on page 139).

■ Sleep mode timer
This timer works for both the printer and the scanner. After the time defined 
in the Océ Settings Editor, the system receives a minimum of power (see 
‘Find system settings in the Settings Editor’ on page 139). The screens on the 
operator panels turn off. The printer cools down. When you press a key on 
either of the operator panels, the printer or scanner activates. The printer will 
need to warm up before becoming operational.

■ Shut off timer
This timer works for both the printer and scanner. After the time defined in 
the Océ Settings Editor, the system will turn off entirely (see ‘Find system 
settings in the Settings Editor’ on page 139). This timer only works when the 
keys in the power switch on the printer and scanner are set to the timer 
position.

■ Wake up timer
This timer works for both the printer and scanner. At the time defined in the 
Océ Settings Editor, the system turns on automatically (see ‘Find system 
settings in the Settings Editor’ on page 139). This timer only works when the 
keys in the power switch on the printer and scanner are set to the timer 
position.
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Figure 5 on page 26 shows the flow of the timers under the following 
conditions:

■ The system remains idle for the period defined in the Océ Settings Editor.
■ Configure the timers in the Océ Settings Editor .
■ The power switches of the printer and the scanner are set to the timer position 

(Shut off timer and Wake up timer only)

Under these conditions the timers work in a circular way. When you use this 
automatic flow of the Océ TDS800 timers, the system will be warmed up and 
ready for operation when you need it and will make economic use of power.

[5] The automatic flow of the Océ TDS800 timers.

The Océ TDS800 
printer and scanner 
are standby

The Océ TDS800 
printer is in low 
power mode

The Océ TDS800 
printer and scanner 
are in sleep mode

The Océ TDS800 
printer and scanner 
turn themselves off

The Océ TDS800 
printer and scanner 
turn themselves on
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▼ How to configure the automatic shut off and wake up timers

1 Use the shut off time-out setting in the Océ Settings Editor to define after how 
many minutes of inactivity the printer and scanner turn off.

2 Use the ‘First working day’ and ‘Last working day’ settings in the Océ Settings 
Editor to define on which days of the week the printer and scanner 
automatically wake up.

3 Use the wake up ‘Time’ setting in the Océ Settings Editor to define the wake 
up time of the scanner and the printer on working days.

▼ How to enable the automatic shut off and wake up timers on the printer and 
scanner

1 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns off.

2 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns on at the time and day defined in the Océ Settings 
Editor.

Note: The timers must be enabled separately on both the scanner and the 
printer.

Before you enable the timers, you must first turn the system off by turning the 
key to the ‘Off’ position. When you then turn the key to the ‘timer’ position, 
the system turns on. The system remains on during the defined time in the shut 
off time out setting in the Océ Settings Editor. The system remains off until the 
defined time in the wake up time setting in the Océ Settings Editor.

Note: The timer settings are stored local on the printer and the scanner. When 
the controller is turned off, the timers still function as configured on the Océ 
Settings Editor.

Before you enable the automatic shut off and wake-up timers, it is possible to 
force the system to turn off. 
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▼ How to force turn off

1 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
he Océ TDS800 turns off

2 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23.

3 When the system wakes up, wait until the systems starts warming up.
Press any key on the operator panel to start warm up.

4 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns off.

5 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23
The Océ TDS800 remains turned off regardless of the timer settings defined in 
the Océ Settings Editor. The Océ TDS800 wakes up on the next working day 
at the time defined in the Océ Settings Editor. 
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Chapter 2
Using the Océ TDS800 to print

This chapter contains a description of the Océ TDS800 
printer function.
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Before you begin

You must turn on both the Océ TDS800 printer and the Océ Power Logic® 
Controller before you can print. See ‘Turn on and off the Océ TDS800’ on 
page 23.
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How to print

See ‘User interaction’ on page 16 for information about how to print to the Océ 
TDS800.
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Printer operator panel

The printer operator panel consists of a number of keys and a graphical display 
(see Figure 6). At the top of the panel is an attention light which starts flashing 
when operator intervention is required.

[6] Printer operator panel

Select a language

On the operator panel of the Océ TDS800 Printer you can specify which 
language you want to use for displaying printer information, such as status and 
error messages.

By default, you can choose between two languages, which have been defined 
for your system by the key operator (see ‘Find system settings in the Settings 
Editor’ on page 139). The Océ TDS800 supports a total of 16 languages. See 
Chapter 6, ‘Océ Power Logic®: Settings Editor’ on page 125 and the On-line 
Help on the Océ Settings Editor. 

Note: If the key operator has specified only one language, it will not be possible 
for you to choose. In that case the language option will not appear on the 
operator panel.

Ready to print

1 A1 Paper
3 A0 Paper
5 36 Paper

2 A2 Paper
4 A3 Paper
6 A0 Paper
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▼ Select a language

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the Language option.
A shadow effect is used to indicate that the focus is set to this option.

3 Activate the Language option by pressing the right selection key.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified language are no 
longer dimmed.

4 Use the arrow keys to switch between the predefined languages.
5 The language specific elements on the display are immediately customized to 

reflect your language choice. Only the indicator for the language itself, is in 
the alternative language. This way you always know what your alternative 
language is.

6 Put the printer On-line again by pressing the ‘On-line’ key. The printer now 
uses the selected language.

Display

The graphical display offers feedback about the current printer status. It 
provides you with the following information: 

■ Status information (e.g. ‘Preparing for run’, ‘Ready to print’, ‘Warming up’).
During normal operation the following message types may appear: 
Status / action message: indicates the actual status of the printer plus the 
action to be taken, e.g. ‘Roll empty. Feed A2, plain paper’.
Warning message: during a warning message the printer will continue to 
operate, but it is possible that the print quality is not optimal, e.g. ‘Fill E1 
toner’.
A graphical overview of available rolls and manual feeds, including the 
material type and size used by each roll or manual feed.

■ An indication that a particular roll is empty.
An empty roll is represented by a dotted roll symbol.

■ In the event of an error, a graphical representation of any error location 
(cover or panel), together with instructions on how to solve the problem is 
displayed.
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Counter

On the operator panel of the Océ TDS800 Printer a counter will be displayed 
that gives the user feedback about the progress of the job that is currently being 
printed. The counter, which is located at the bottom of the upper window on 
the operator panel, displays the number of sets and the pages printed. Counting 
starts at 1. The following options are available:

■ When no sets are made, only the current page and the total number of pages 
are displayed (e.g. ‘Page 3 of 5’). At the beginning of a job, when the system 
does not know the total number of pages yet, only the current page may be 
displayed (e.g. ‘Page 5’).

■ With set input: set counter. In this case the counter shows the current, the 
total number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). At the 
beginning of a job, when the system does not know the total number of sets 
yet, only the current set and page may be displayed (e.g. ‘Set 2, Page 5’).

■ With set input: multiple sheet counter. In this case the counter shows the 
current page, the total number of pages and the current copy, e.g. ‘Page 2 of 
12, Copy 5’). At the beginning of a job, when the system does not know the 
total number of pages yet, only the current page and copy may be displayed 
(e.g. ‘Page 2, Copy 5’).

■ With set input: Océ Matrix logic®. In this case the counter shows the current, 
the total number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). At 
the beginning of a job, when the system does not know the total number of 
sets yet, only the current set and page may be displayed (e.g. ‘Set 2, Page 5’).

 

Keys

With the keys on the operator panel you can make a number of settings for the 
Océ TDS800 Printer, such as the media type and size or the preferred language.
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The following keys are available: 

Key types
Key Function

Selection
keys

The selection keys are located immediately below the graphical 
display. The left key can be used to activate one of the main menu 
choices (Language, Folding or 
Media) on the left part of the display. 
Note: A shadow highlighting effect is used to indicate the active 
menu option.
The right selection key can be used to activate the options on the 
right part of the graphical display.
Note: To identify the active selection, the dotted line around this 
selection is changed into an uninterrupted line and the small 
selection triangles next to the specified option are no longer 
dimmed.
These selection triangles indicate that you can select an option 
from a predefined list with the help of the arrow keys.

Arrow 
keys 

These two triangular keys to the right of the graphical display are 
used to display the next or previous option from the selected menu 
choice and to select the desired option.

On-line key By pressing the On-line key you can put the printer On-line or 
Off-line. If the green light above the On-line key is on, the printer 
is On-line; if this light is off, the printer is Off-line.

Stop key The red Stop key is used to stop the present print job. After this 
key is pressed, a dialog is displayed asking for confirmation.

Note: The printing process does not stop instantaneously since a 
number of prints may already have been submitted to the printer 
after processing. The prints cannot be stopped.

Extra key This key is reserved for future use.
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Printer operator panel actions

On the Océ TDS800 printer operator panel you can perform a number of 
actions: 
■ Set the media type
■ Set the media type for manual feed
■ Set the media size
■ Set a special media indication
■ Stop a print job
■ Select the preferred languages
■ Clean the reinforcement knives

Media types and sizes on the printer

One of the features of the Océ TDS800 printer is the automatic media change 
function. This function enables the printer to switch to another roll of the same 
media when there is not enough media on the current roll to finish the print run.

Specify media type and the media size after you load media, as described in 
‘Maintenance’ on page 205. The Océ TDS800 supports both DIN and ANSI 
media formats.

See ‘List of available material types and sizes’ on page 253 for an overview of 
all materials that can be used on the Océ TDS800 Printer. See‘Overview of 
paper series’ on page 254 for formats included in the paper series.
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▼ Set media type

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window.

[7] The Printer Operator panel in Off-line mode

The focus shifts to the Media option (indicated by the shadow effect).
2 Use the arrow keys to select the roll or manual feed for which you have just 

loaded new media.
3 Press the right selection key to activate the Mat. (Material) option.

The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified material are no 
longer dimmed.

4 Use the arrow keys to select the material you just loaded.
5 Press the ‘On-line’ key to put the printer On-line again. The printer now knows 

which material is used for the specified roll or manual feed.

▼ Set media type for manual feed

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the Manual option.
4 Press the right selection key to activate the Mat. (Material) option.

The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified material are no 
longer dimmed.

5 Use the arrow keys to select the material you just loaded.
6 Press the ‘On-line’ key to put the printer On-line again. The printer now knows 

which material is used for manual feed.

Ready to print

1 A1 Paper
3 A0 Paper
5 36 Paper

2 A2 Paper
4 A3 Paper
6 A0 Paper
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▼ Set media size

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window (see Figure 7).

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the roll or manual feed for which you have just 
loaded new media.

4 Press the right selection key to activate the Size option.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified size are no longer 
dimmed.

5 Use the arrow keys to select the size for the media you just loaded.
The printer shows both DIN and ANSI sizes. Select the correct format.

6 Press the On-line key to put the printer On-line again. The printer now knows 
which media size is used for the specified roll or manual feed.

Special media indication

On the Océ TDS800 Printer, you can attach a Special indication (exclamation 
mark:!) to a roll or manual feed which uses special media (for instance colored 
paper). This indication is used to identify the roll or manual feed to the printer. 
For this roll or manual feed the automatic media change option is disabled.

▼ Set a special media indication

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window (see Figure 7 on 
page 37).

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the roll or manual feed for which you have just 
loaded special media.

4 Press the right selection key to activate the ‘Type’ option.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified type are no longer 
dimmed.

5 Use the arrow keys to select the Special option for the specified roll or manual 
feed.

6 Press the ‘On-line’ key to put the printer On-line again. The printer now knows 
that the specified roll or manual feed contains special material.
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Stopping a print job

The red ‘Stop’ key on the Océ TDS800 Printer operator panel interrupts the 
active print process. You can cancel or continue the current print job.

▼ Cancel a print job

1 Press the ‘Stop’ key. 
A dialog is displayed informing you that you can press ‘On-line’ to continue 
or press the ‘Stop’ key to cancel the job.

2 Press the ‘Stop’ key again to cancel the current job.
Note: Printing is stopped at the end of a page. Started prints are finished.

▼ Continue a print job

1 Press the ‘Stop’ key. 
A dialog is displayed informing you that you can press ‘On-line’ to continue 
or press the ‘Stop’ key to cancel the job.

2 Press the ‘On-line’ key to continue the current print job
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Print with Océ Print Exec® Workgroup

Introduction

Océ Print Exec® Workgroup is an optional print job submission application 
which allows you to send print jobs to the Océ TDS800 through your web 
browser. Enable Océ Print Exec® Workgroup with a password in the Océ 
Settings Editor. Océ Print Exec® Workgroup allows you to do the following.

1 Select and collect the files to print (documents and drawings), in a print job.
2 Configure the print job.
3 Preview the files to print.
4 Submit the print job.
5 Check the print job and the printer configuration status.

Options

Océ Print Exec® Workgroup has the following options.

■ View status information about the printer configuration and available media.
■ View status information of submitted print jobs in the historic queue.
■ Set the document or drawing settings.
■ Set the job settings for a print job.
■ Add a settings configuration for a print job.
■ Add a maximum of 100 documents or drawings to a print job.
■ Add documents or drawings from the Océ Doc Exec® archive.
■ Add a stamp to the document or drawing.
■ Add a banner to the print job.
■ Preview the document or drawing before you print.
■ Save and retrieve print jobs.
■ Submit print jobs to printer queue or inbox queue.
■ Manage serveral print jobs.

Connect to Océ Print Exec® Workgroup
Requirements for the browser software and network.  ■
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■ Microsoft® Internet Explorer® 5.0 or higher versions, or
■ Netscape Navigator® 6.0 or higher versions.
■ TCP/IP network which connects the printer and the end user workstation.

▼ How to connect to Océ Print Exec® Workgroup

1 Enable Océ Print Exec® Workgroup in the Océ settings editor.
(see ‘Find system settings in the Settings Editor’ on page 139).

2 Enter the following link URL in you browser: http://printer name.
When you enter the URL for the first time, the required software is installed 
automatically at your workstation.

The documentation set

The complete documentation set of Océ Print Exec® Workgroup includes the 
following.

■ The Océ Print Exec® Workgroup user manual
■ The on-line help files in the Océ Print Exec® Workgroup application.
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Print with Océ Repro Desk

Introduction

Océ Repro Desk is the preferred print management solution for reprographers. 
Océ Repro Desk consists of the following two parts.

■ Océ Repro Desk Remote software which facilitates the electronic 
submission of drawing files and print request from the clients to their 
reprographers.

■ Océ Repro Desk Server which provides the reprographers with extensive 
print management and accounting functions to maximise the productivity of 
their print equipment assets. 

The documentation set

The complete documentation set of Océ Repro Desk includes the following.

■ The Océ Repro Desk user manual
■ The on-line help files in the Océ Repro Desk applications.
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Chapter 3
Using the Océ TDS800 to Copy

This chapter contains a description of the interface of the 
Océ TDS800 scanner and the copy function on its operator 
panel.
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Before you begin

You must turn on both the Océ TDS800 scanner and the Océ Power Logic® 
Controller before you can perform copy jobs. See ‘Turn on and off the Océ 
TDS800’ on page 23.
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Scanner operator panel

Press the green Start key on the scanner operator panel to start the original 
transport on the scanner. To perform more complex copy jobs, change the 
default settings on the scanner operator panel.

The scanner operator panel is located above the original feed. As you can see 
in figure 8 on page 45. The panel consists of a display in the center surrounded 
by a number of function, section and ‘Arrow’ keys. To the left of the display, 
you can find the Stop and Job interrupt keys and below the display you can find 
the Start, Numeric and Correction keys.

This section consists of two parts. The first part explains the basic use of the 
keys. The second part deals with special use of the display. It describes how to 
use the soft keys above and along the sides of the display to define your copy 
settings.

.

[8] Scanner operator panel

1 2
3

4 5

6789121314

10
9
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1 The exposure control
2 The display
3 The Section keys
4 The Arrow keys
5 The Media selection keys
6 The Manual feed key
7 The Auto roll key
8 The Correction key
9 The Stop key

10 The Job interrupt key
11 The Numeric keys
12 The Function keys
13 The numeric display
14 The Start key

Exposure control  The exposure control is located on the left side of the 
operator panel. The scale displays the current exposure rate. Control the 
exposure with the keys. More exposure makes the output darker. Less exposure 
makes the output lighter.

The Media selection keys  There are 6 Media selection keys, one for each roll. 
Press the Media selection key to select the roll with the required format and 
media type.

The Manual feed key  If you want to copy on a material type or size that is not 
available in one of the roll compartments, press the manual feed key. The key 
is located on the right section of the operator panel.

The Auto roll key  If you select auto roll, the Océ TDS800 will try to use a roll 
format that matches the original size. After inserting the original, the roll that 
is used is indicated on the operator panel.

When auto roll is selected, the Océ TDS800 will look for a matching roll of the 
‘Standard’ copy material. If such a roll is not found, it will try to find a 
matching roll of another type of material. The Key Operator can define the 
‘Standard’ copy material.

When automatic zoom is selected on the display of the operator panel, together 
with auto roll, the size of the matching roll does not necessarily have to be the 
same as the size of the original.
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The Correction key  The orange key marked with C is located at the bottom of 
the central section of the operator panel. Press the Correction key one time to 
reset the selected setting to its default value. Press the Correction key two times 
to reset the numeric display to ‘1’. Press the Correction key three times to 
return to the first screen on the display.

The Stop key  Press this red key to Stop the job. For more information see 
‘Stop a job’ on page 63.

The job interrupt key  You use the Job interrupt key to set extra priority to your 
copy job or to remove extra priority from your copy job. Determine the priority 
of your copy job with the Job interrupt key before you scan your originals. The 
job is placed on top of the printing queue in the queue manager.The interrupt 
job will start running directly after the current printing page is completed. No 
new job is send to the printer.

The Numeric keys  The keys with numbers on the lower part of the middle 
operator panel are used to specify numbers. Values you can set with the 
numeric keys include: the number of copies or sets up to a maximum of 999, 
zoom factor, user id, and account id.

The ‘numeric display  Displays the number of sets or copies, set with the 
numeric keys.

The Start key  Use the green Start key to start the feeding of the original, to 
restart the scan process, or for other purpose such as to mark the end of a set.
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Section, Function and Arrow keys

Apart from the above mentioned keys, the operator panel of the Océ TDS800 
scanner contains a number of other keys. These include:
■ Section keys
■ Function keys
■ ‘Arrow’ keys.

The Section keys are the four keys located above the display. These keys 
provide access to the ‘Custom’, ‘Original’ and ‘Copy’ sections on the display. 

Each section contains several function cards. These can be accessed with the 
help of the left most Function key.

The five “Function’ keys below the display allow you to select functions or 
subfunctions within a card. 

Finally, the ‘Arrow’ keys can be used, like the Numeric keys, to define numeric 
settings. The ‘Arrow’ keys can be used to increase or decrease the active value 
by 1; the left ‘Arrow’ and right ‘Arrow’ keys can be used to increase or 
decrease the active value by 10. Exception to this rule is the selection of zoom 
values. Here, the left ‘Arrow’ key can be used to browse through the predefined 
reduction steps and the right ‘Arrow’ key to browse through the predefined 
enlargement steps. 

The ‘Arrow’ keys are also used for selecting subfunctions. 
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Sections on the display of the scanner operator panel

When the job templates are enabled, the scanner operator panel displays the 
templates (see Figure 9). You need to select a template before the sections will 
display.

[9] The job templates at the bottom of the scanner operator panel.

When the job templates are disabled or you selected a job template, the scanner 
operator panel displays the following sections with an active ‘Custom’ section 
(see Figure 10 on page 50).

■ The ‘Custom’ section which provides direct access to frequently used 
settings, defined by the customer.

■ The ‘Original’ section which provides access to the settings of the scanner 
input, the original.

■ The ‘Print’ section which provides access to the settings of the printer output, 
the print.

■ The ‘File’ section which provides access to the settings of the scan-to-file 
output, the file.

Custom section

The ‘Custom’ section contains the frequently used settings. Figure 10 on 
page 50 shows an example with the following settings.

■ Zoom
■ Input mode
■ Output
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[10] The sections at the top with an active ‘Custom’ section (default)

The key operator defines the contents in the Océ Settings Editor on the Océ 
Power Logic controller (see ‘Define the contents of the custom card’ on 
page 136). The key operator can change the contents, dependent on your 
configuration, for example into the following settings.

■ Folding
■ Language
■ Exposure

Original section

The ‘Original’ section contains all settings for the scanner input, the original 
(see Figure 11 on page 50). The settings are divided over the following cards.
■ Scanner
■ Image
■ Sheet
■ Feeding

[11] The cards of the ‘Original’ section at the left side with an active ‘Feeding’ card
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Print section

The ‘Print’ section contains all settings for the printer output, the print (see 
Figure 12 on page 51). The settings are divided over the following cards.
■ Image
■ Layout
■ Finishing
■ Sheet

[12] The cards of the ‘Print’ section at the left side with an active ‘Finishing’ card.

File section

The ‘File’ section contains all settings for the scan-to-file output, the file (see 
Figure 13 on page 51). The ‘File’ section is only available if you have the 
scan-to-file option installed (see Chapter 4, ‘Using the Océ TDS800 to 
scan-to-file’ on page 67).

[13] The cards of the ‘File’ section at the left side with an active ‘Destination’ card.
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Job templates

A job template contains all settings for a job. Figure 9 on page 49 shows an 
example with the following job templates.

■ Template 1
■ Template 2
■ Template 3
■ Template 4
■ Last used

The key operator defines the settings in the Océ Settings Editor on the Océ 
Power Logic controller (see ‘Define the job templates’ on page 137). The key 
operator can change the job template names, except for ‘Last used’, for 
example into the following job names.

■ Single copy
■ Set copy
■ Matrix copy
■ Scan-to-file
■ Last used

When you select the ‘Last used’ job template, you recall all settings from the 
previous job. You can change the settings or do the same job again. The ‘Last 
used’ job template does not display when you turn on the scanner.

After you select a template, the sections display. The sections provide access 
to the settings for the scanner input, the printer output and the scan-to-file 
output (see ‘Sections on the display of the scanner operator panel’ on page 49). 
Use the Custom Card here to provide access to frequently used settings 
reffered to the type of job.

Change the operator panel language

It is possible to change the operator panel language. You can choose between 
two preferred languages. Define the first and second language on the Océ 
Settings Editor (see ‘Find system settings in the Settings Editor’ on page 139). 
The Océ TDS800 supports a total of 16 languages. See Chapter 6, ‘Océ Power 
Logic®: Settings Editor’ on page 125 and the On-line Help on the Océ Settings 
Editor.
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▼ How to select a language

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Language’ function key to set the needed language.

Change default settings on the scanner operator panel

When job templates are enabled in the Océ Settings Editor, the job templates 
are displayed on start-up of the Océ TDS800 scanner (see Figure 9 on 
page 49). When job templates are not enabled in the Océ Settings Editor, the 
‘Custom’ section is displayed on start up (see Figure 10 on page 50).

▼ How to change dedault settings

1 Select a template (only applies when job templates on the scanner operator 
panel are enabled in the Océ Settings Editor).

2 Press one of the Section keys to activate the desired menu.
Note:  The active menu is slightly moved downwards to visually separate it 
from the other menus. Apart from that, a shadow highlighting effect is used 
for extra highlighting.

3 Press the Selection key to select the appropriate card. You can switch cards 
(from bottom to top) by pressing the key again.
Note: Here, too, the active card is visually separated from the other cards 
and given a shadow highlighting effect for extra highlighting.

4 Select the desired function values in one of the following ways:
■ Simple (non-numeric) selection: press the Function key to activate the 

desired (non-numeric) value. The selected value is preceded by a ‘●’ symbol. 
■ Long list selection: if you want to select a value from a list of options that can 

not be fully displayed on the panel, you first activate the selection triangles 
next to the specified option (the dotted line around this selection is changed 
into an uninterrupted line and the selection triangles are no longer dimmed), 
which indicate that there are additional options available and then select one 
of the non-displayed values with the ‘Arrow’ keys. The ‘Original type’ 
setting demonstrated in figure 11 on page 50 is an example of this.

■ Numeric selection: activate the selection triangles and select the desired 
value with the ‘Arrow’ keys or with the numeric keys. 

Also a combination of simple selection and numeric selection is possible.
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The Correction key  use the Correction key to do the following:

1 Press the Correction key one time to return to the default value of the active 
setting.

2 Press the Correction key two times to set the numeric display to 1.
3 Press the Correction key three times to return to the top layer of the Scanner 

Operator Panel. When job templates are enabled in the Océ Settings Editor the 
top layer shows the job templates. When job templates are not enabled in the 
Océ Settings Editor, the top layer shows the ‘Custom’ section.

When ‘Automatic feed’ is selected for a single sheet job, this setting stays 
active.

Job interrupt only stays active for one job. You have to press the Job interrupt 
key before each new job you want to give interrupt priority.

The Scanner Operator Panel will automatically return to the top layer and the 
default settings after the time defined in the ‘Panel Time-out’ setting in the Océ 
Settings Editor (see ‘Find system settings in the Settings Editor’ on page 139).
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Perform basic copy jobs

On the Océ TDS800 scanner operator panel you perform a number of basic 
tasks. These include:
■ Make copies
■ Select the required media
■ Select the input mode
■ Specify the zoom factor
■ Define settings for the next original
■ Account logging
■ Using the manual feed for copy jobs
■ Define delivery of copies
■ Stop a job
■ Interrupt a job
■ Stamping

Make copies

1 Place your original face-up, left aligned along the original guide. Keep the 
legend at your left hand side.
Note: When you feed the original, keep it in place until it is transported 
(about 1 cm) into the machine.

[14] Insert the original

2 Specify the number of copies using the numeric keys. 
3 Specify the ‘Paper series’ on the ‘Sheet’ card in the ‘Original’ section.
4 Specify the desired media on the operator panel. 
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If you select ‘Automatic’ the Océ TDS800 will try to use a roll format that 
matches the specified size.
Select a specific roll to use the media you want.
If you select ‘Automatic’, the Océ TDS800 will use a zoom factor that is 
needed to obtain a copy without loss of information. After inserting the 
original, the zoom factor that is used is indicated by the ‘●’ symbol. 
Note: The zoom factor is based on the selected media size.

5 Specify the desired brightness on the operator panel. 
You can use the ‘Brightness’ setting to correct for a lighter or darker original.

6 Specify a reduction or enlargement factor on the operator panel by using the 
‘Zoom’ function.

7 Specify folding options on the operator panel. 
If the optional folder is installed, you can use the ‘Folding’ settings to get a 
neatly folded copy. 

8 Press the green start key to start the copy job.
Your original will be fed into the scanner. The printer starts.

9 Collect your output.
Your copy will be delivered on the selected output unit of the print engine.

Select the required media

The ‘Media’ setting can be used to select media and format. The display will 
show you what media rolls are currently loaded. If you select ‘Automatic’, the 
Océ TDS800 will try to use a roll that matches the original size. After inserting 
the original, the roll that is used is indicated by a led that is on.

Note: The led remains on until a new original is inserted.

Select the media type and paper series on the scanner operator panel. First 
select the paper series, then select the media size. Only the media in the defined 
paper series are available.

(see Table  on page 254).

Attention: Selecting another paper series than is actually loaded on the 
printer can cause information loss on the output.
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▼ Select the paper series

1 Select the ‘Sheet’ card in the ‘Original’ section
2 Select the required paper series with the ‘Paper series’ function key

[15] Select the required paper series

▼ Selecting the required media

1 Select the one of the six rolls on the scanner operator panel.
The corresponding led turns on.

Access to
ial

Access to
Page

interrupt
job
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Select the input mode

You can use the ‘Input mode’ setting to specify how a job will be sorted: the 
‘Single sheet’ option treats each sheet as a separate job. ‘Multiple sheets’ 
produces the specified number of copies for each sheet in a job and then 
continues with the next sheet. Graphically this looks as follows:

[16] The principle of ‘Multiple sheets’

‘Set’ produces one copy for each sheet in a set and then continues with the next 
copy of the entire set, as follows:

[17] The principle of’Set’

See ‘Make a set copy’ on page 111.

The input mode Matrix copy enables you to create several print jobs out of one 
scanned set. See Chapter , ‘Océ Matrix Logic® introduction’ on page 112.

The current input mode can be closed by pressing the Stop key.

The currently selected input mode is indicated by the ‘●’ symbol.

▼ Select the input mode

1 Select the ‘Feeding’ card in the ‘Original’ section.
2 Select the input mode with the ‘Input mode’ function key.

1 1 1 2 2 2 3 3 3 4 4 4

1 2 3 1 2 3 1 2 3 1 2 3
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[18] Select the input mode

Note: You can also select the input mode from the ‘Custom’ section (if this 
setting has been defined for this).
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Specify the zoom factor

You can use the ‘Zoom’ setting to select a zoom factor. 

▼ Selecting the zoom factor

1 Select the ‘Image’ card in the ‘Print’ section.
2 Select Automatic, 1:1, or set the zoom factor on the display of the operator 

panel

■ Automatic zoom selection: the system automatically calculates the zoom 
ratio based on the original size and the output media size

■ 1:1: Results in an image that is exactly the same size as the original.
■ Set the zoom factor on the display of the operator panel: 

Use the ‘Arrow’ keys on the right of the display (see Figure 8 on page 45). If 
you press one of the vertical keys, the zoom factor will increase or decrease 
with steps of 0.1%. If you press one of the horizontal keys, the zoom factor 
will increase or decrease with the steps predefined in the Océ Settings editor 
by the key operator (see ‘Find system settings in the Settings Editor’ on 
page 139).
Use the numeric keys at the bottom of the operator panel. You can specify 
the exact zoom factor with 0.1% increments.
For example, if you want to specify a zoom factor of 25.4%, you type 254. If 
you want to specify a zoom factor of 254%, you type 2540.

[19] Selecting the zoom factor

Note: You can also select the zoom factor from the ‘Custom’ section (if this 
setting has been defined for this).
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Define settings for the next original

You can define the settings for each original you want to copy. When 
‘Automatic feed’ is enabled, you should bear in mind that the original is 
automatically pulled into the scanner. If you want to be absolutely sure about 
the settings that belong to an original, insert an original when the settings are 
correct.

Note: You can turn off Automatic feed on the scanner. This offers you the 
possibility to change the settings for the next original, even if you already put 
the original in place on the scanner feed table.

▼ Define settings for the next copy job

1 Select all settings required for the next original.
2 Insert the next original.

If ‘Automatic feed’ is off, press the start key. 
If ‘Automatic feed’ is on, the original is fed automatically.
Note: You can enable or disable this function from the ‘Scanner’ card in the 
‘Original’ section.

Account logging

For accounting purposes, the system is able to log job information for each job. 
The job identification attributes and the number of print jobs are logged in the 
account file. For more information on account logging see chapter 10 on 
page 171.

Note: The account settings are only available if the accounting option is 
enabled in the system configuration.

[20] Accounting function
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▼ Select accounting

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Select ‘Account id’ or ‘User id’ with the section key.
3 Set the needed ‘Account id’ or ‘User id’ with the ‘Arrow’ keys.

Using the manual feed for copy jobs

If you want to copy a job on a media type or size that is not available on one of 
the media rolls, it can be convenient to manually feed cut sheets instead of 
switching media rolls. The manual feed is a special slot just above the roll 
drawers on the print engine. You can insert pre-cut copy material in this slot, 
one sheet at a time.

Note: Only use media as specified in ‘List of available material types and sizes’ 
on page 253. 

▼ Copying on pre-cut sheets

1 Press the Manual feed key on the Scanner.
2 Select any required other settings.
3 Enter the number of copies using the numeric keys.
4 Feed the original. The printer display looks as follows:

[21] The printer operator panel with manual feed message

5 Press the start key.
6 Take your sheet of copy material to the side of the printer engine that contains 

the Manual feed. 
7 Use both hands to align the copy material in accordance with the format 

indication and the sticker on the manual feed table.
8 Move the copy material forward in the nip of the roller. This must cause an 

ample paper bulge over the full width of the page.
9 Hold the paper with both hands until the engine pulls in the first part of the 

sheet.
The bulge will be reduced or it will disappear. A few seconds later the complete 
sheet will be pulled in the printer.



Using the Océ TDS800 to Copy 63

Note: If the copy job requires more sheets, the display will ask you to feed 
the next sheet.

10 Repeat steps 7 to 11 to complete the job.
11 Collect your output.

Stop a job

Pressing the Stop key interrupts the original transport. 

▼ How to stop a job

1 Press the Stop key.
The original transport is now stopped and you are prompted to open the 
scanner cover in order to remove the original.

2 Open the cover.
3 Remove the original. 
4 Close the cover. 

You are now ready to start the next copy job.

Interrupt a job
Press the Job interrupt key on the scanner operator panel to give extra priority 
to a copy job. When you press the Job interrupt key your copy job will be 
placed on top of the printing queue. When you select Job interrupt a message 
appears on the scanner panel display (see ‘Feedback on the scanner panel 
display when Job interrupt is selected.’ on page 63).

An interrupt job will interrupt a copy job at page level. You can create many 
interrupt jobs, but an interrupt job cannot interrupt another interrupt job.

[22] Feedback on the scanner panel display when Job interrupt is selected.
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The print process will be interrupted after the current page is printed. The 
transport of originals on the scanner will not be interrupted.

▼ How to interrupt a job

1 Press the Job interrupt key on the Scanner operator panel.
The printer interrupts the active job and stops after the current page is printed.
The Océ Queue Manager displays the interrupt job in the print queue at the 
active job position .
The Océ Queue Manager displays the interrupted job with the icon .

The Océ Queue Manager displays the interrupt job with the icon .

The Océ Queue Manager changes the exit interrupt button from gray into 
colored and changes this button into the active condition.

2 Make copies (see ‘Make copies’ on page 55).
3 Press the Job interrupt key again to do another interrupt job.

Press the Exit interrupt button at the Océ Queue Manager to continue with the 
interrupted job and collect the output at a later time.
Collect the output and press the Exit interrupt button at the Océ Queue 
Manager to continue with the interrupted job.

Managing of interrupt jobs in the Océ Queue Manager  

There can be several new jobs in the queue during Job interrupt. They are 
put in a First In First Out sequence. In the Océ Queue Manager you can 
manage interrupt jobs in following way:

■ An interrupt job can be canceled in Océ Queue Manager. 
■ An interrupt job can be put on hold. An interrupt job will lose its priority 

position in the queue when put on hold. 
■ When there are more interrupt jobs, an interrupt job can be moved to the top 

of the printing queue.
■ When job interrupt is enabled on the scanner operator panel, you must use 

‘Exit interrupt’ button on the toolbar to continue the normal, interrupted, 
jobs.

▼ Continue interrupted jobs

1 Press the ‘Exit interrupt’ button
The system continues the interrupted jobs after the interrupt jobs are 
completed.
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Stamping

Stamping is an Océ TDS800 option which allows you to print a predefined text 
on all your copies. Enable stamping with a password in the Océ Setting Editor. 
The key operator can predefine a maximum of 50 stamps in the Océ Settings 
Editor (see ‘Find system settings in the Settings Editor’ on page 139).

You can select one stamp per original and you can select a colour, font size or 
position. A stamp can consist of the following parts:

■ predefined text
■ date
■ time

▼ How to select a stamp

1 Open the ‘Stamping’ card in the ‘Print’ section.
2 Select stamp ‘On’ with the ‘Enable’ function key.
3 Select a stamp with the ‘Select stamp’ function key.

Note: the following steps are optional.

4 Select a ‘Colour’ with the ‘Format stamp’ function key and the arrow keys.
5 Select a ‘Size’ with the ‘Format stamp’ function key and the arrow keys.
6 Select a position with the ‘Stamp position’ function key and the arrow keys.
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Chapter 4
Using the Océ TDS800 to 
scan-to-file

This chapter describes the scan-to-file function of the 
TDS800. This chapter contains a description of the 
interface of the Océ TDS800 scanner, and of Océ Scan 
Manager and Océ View Station LT applications on the Océ 
Power Logic® controller
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Before you begin

You must switch on both the Océ TDS800 printer and the Océ Power Logic® 
Controller before you can scan-to-file. See ‘Turn on and off the Océ TDS800’ 
on page 23.
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Scanner operator panel

For a description of the scanner operator panel and how to perform actions on 
the scanner operator panel, see the ‘Scanner operator panel’ on page 45.
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Océ Scan Logic®

Océ Scan Logic® is an option which enables you to scan a document to a file 
for later use. You enable scan-to-file with a password in the Océ Settings Editor 
(see ‘Find system settings in the Settings Editor’ on page 139).

You use scan-to-file to:
■ print documents at a later time
■ archive documents
■ email documents
■ reuse the information documents contain in another applications

A scan-to-file is made at the Océ TDS800 scanner. On the scanner operator 
panel you can select at which resolution you want to scan and where you want 
to store your file. 

The result of the scan-to-file can be stored local on the controller (temporary 
store) or directly on a network destination via SMB or FTP. 

Océ View Station LT® enables you to view the scanned documents. Océ View 
Station LT® starts up from the Océ Scan Manager application. Select Auto 
view to automatically start up Océ View Station LT® after scan to file.
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Scan clicks

The Océ TDS800 measures the area of media that you scanned during scan to 
file operations. You view the scan click count in the bottom right corner of Océ 
Scan Manager (see Figure 23 on page 71).

The scan click count is measured in square feet or square meters (see ‘Find 
system settings in the Settings Editor’ on page 139). You set the measurement 
unit in the Océ Settings Editor (see Chapter , ‘Measurement’ on page 94).

[23] Scan click count in Océ Scan Manager
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Make a scan-to-file

Do the following to scan an original to file.

▼ How to scan to file

1 Place your original face-up, left aligned along the original guide.
2 Select the appropriate original type.
3 Select the ‘Destination’ card in the ‘File’ section.

[24] ‘Destination’ card in the file section

4 Select ‘File mode’ On.
The status message displays: Ready to scan to file.

5 Select a Destination (see ‘Destinations’ on page 82).
6 Set the correct settings. (see Chapter , ‘Settings for scan-to-file’ on page 74)
7 Press the start key.

The original is scanned. 
A status message displays (see Figure 25 on page 72):
‘Scanning job’ ‘Scan job number X’
‘File scan22.tif’

[25] File card on the Scanner operator panel
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8 When ‘System’ - ‘Auto view’ is enabled on the Océ Scan Manager, Océ View 
Station LT® starts automatically, showing the result of the scan (see 
Figure 26).

[26] Océ View Station LT
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Settings for scan-to-file

The settings for scan-to-file on the scanner operator panel are divided into two 
cards: Destination and Image.

Destination card:
■ Destination
■ File type
■ TIFF sub format
■ PDF compression

[27] Scanner operator panel: Destination card

Image card:
■ Resolution
■ Zoom
■ Optimisation
■ Mirror

[28] Scanner operator panel: Image card
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File mode

File mode can be ‘Off’, ‘On’ or ‘On with checkprint’. ‘Off’ means scan-to-file 
is not active. ‘On’ means scan-to-file is active. To scan to file with a checkprint, 
activate both the file mode and the print mode on the scanner operator panel. 
The checkprint quality corresponds to the scan resolution. A checkprint is a 
print of the scanned original, ensuring consistency with a later print of the 
scanned file.

▼ How to scan to file with checkprint

1 Press the section key above the File section two times
The File mode is switched on

2 Press the section key above the Print section two times
The Print mode is switched on

3 The system is now ready to scan-to-file with checkprint.

Note: The Océ TDS800 system does not allow you to change the ‘File mode’ 
setting during a set from ‘On’ to ‘Off’ and the other way round. However 
changing from ‘On’ to ‘On with checkprint’ and vice versa is allowed.

Note: In scan-to-file mode the automatic behavior is optimised for scanning. 
Turning checkprint on or off does not influence this automatic behavior.

Destination

You can store your scan either in the temporary store on the controller or on a 
network destination. You can define up to ten destinations in the Océ Scan 
Manager application. Select the destinations defined in Océ Scan Manager on 
the scanner operator panel. You can only select one destination at a time.

▼ Select a destination

1 Press the function key to select destination.
Note: Define the names of the destinations in Océ Scan Manager (see ‘Create 
a local destination’ on page 82).
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File format

To define the internal organisation of the scanned files, choose between TIFF 
(Tagged Image File Format) and CALS-I (Continuous Acquisition and 
Life-Cycle support), or PDF (Portable Document Format).

TIFF  describes image data that typically comes from scanners, frame grabbers, 
and paint- and photo-retouching programs. The purpose of TIFF is to describe 
and store raster image data. A primary goal of TIFF is to provide a rich 
environment within which applications can exchange image data. This 
richness is required to take advantage of the varying capabilities of scanners 
and other imaging devices. For example TIFF supports lossless image 
compression. Though TIFF is a rich format, it can easily be used for simple 
scanners and applications as well because the number of required fields is 
small.

CALS  is an industry strategy for transition of paper-intensive processes to 
highly automated, integrated processes for defense system acquisition, design, 
manufacturing, and life cycle support. 

PDF  Portable Document Format (Adobe® Postscript® 3™ /PDF) is a file 
format that has captured all the elements of a printed document as an electronic 
image that you can view, navigate, print or forward.

Tiff sub format

Within the ‘Tiff sub format’ option, you can define the ‘Organization’ and 
‘Compression’ of the file.

Organization  can be (select with the arrow keys):
■ Striped
■ Tiled
■ Raw

Note: Only choose ‘Striped’ or ‘Tiled’ when you are sure you can use these 
organizations afterwards. Choose ‘Raw’ in any other case.

Compression  can be (select with the arrow keys):
■ Group 4
■ Group 3-1D
■ None
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Note: Only choose ‘Group 4’ or ‘Group 3-1D’ when you are sure you can use 
these compressions afterwards. Choose ‘None’ in any other case.

Note: If you scan greyscales or dark originals then use Group 3-1D 
compression. In these cases group 4 can increase the file size.

Note: ‘Group 4’ or ‘Group 3-1D’ are compression methods which are 
optimized for text and vector drawings. If you choose these compressions when 
scanning a photo with many greyscales these compressions can result in a 
negative compression: the file size increases instead of decreases. So use these 
compressions with care.

PDF compress

Within the ‘PDF compress’ option, you can define the ‘Compression’ of the 
file.

Compression  can be (select with the arrow keys):
■ Group 4
■ None

Note: Only choose ‘Group 4’ when you are sure you can use this compression 
afterwards. Choose ‘None’ in any other case.

Resolution

The Océ TDS800 scan-to-file option allows you to scan at the following three 
resolutions:

■ 200 dots per inch (dpi)
■ 300 dpi
■ 400 dpi

The higher the resolution the better the image quality. Higher resolution also 
leads to larger file sizes. The default value is 200 dpi.
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Zoom

The ‘Zoom’ option allows you to scale while scanning to a file. When you set 
‘File mode’ to ‘On’ then the automatic ‘Zoom’ setting will result in ‘1:1’. You 
can change this default setting into one of the following three settings:

Custom  This option lets you specify a custom zoom value. You can enter a 
range from 25% through 400%. This value also shows the zoom value when 
the option ‘Automatic’ is chosen.

1:1  With this option selected, scan-to-file will result in an image that is exactly 
the same size as the original. ‘Zoom’ displays 100%.

Automatic  Selecting ‘Automatic’ always results in a 1:1 scan-to-file. 

Optimisation

There are two ways to optimise a scan-to-file

Scan quality  optimises for the best image quality. The scan resembles the 
original as close as possible.

File size  optimises for better compression. Generally resulting in a smaller file 
size. Image quality can slightly decrease.

Mirror

You can use the ‘Mirror’ option to scan a horizontally mirrored image of an 
original. Mirroring is performed in the vertical axis.
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Océ Scan Manager

The Océ Scan Manager is an application available only local on the Océ Power 
Logic® controller. With the Océ Scan Manager you can configure the 
destinations for scan-to-file. To increase your productivity you can define 
automatic file naming. This way you can do batch scans without operator the 
controller.

During scan to file, Océ Scan Manager displays the file name and the status of 
the file generation process. When the scan is completed a view of the scanned 
image is automatically displayed on the controller.

Figure 29 on page 79 shows the Océ Scan Manager application. The left part 
displays a tree view containing folders containing destinations. The right part 
displays a table view containing the content of the folder currently selected. In 
29 on page 79 folder ‘Next Dest(8)’ is selected.

[29] Overview of the Océ TDS800 Océ Scan Manager application

Note: Not all options are available to all users. You must log on to a particular 
user mode to perform specific tasks with Océ TDS800 Océ Scan Manager (see 
‘User modes’ on page 163).
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Tree view

The tree view displays:
■ the system name
■ the collapsible destination tree
■ the collapsible temporary store tree.

If you scan to a particular destination, that destination is displayed bold and 
the corresponding icon changes. The destination you scanned last to, is 
displayed bold.

If you select a destination, to view it’s content in the right table view, this 
destination will show selected.

If for any reason a scan-to-file cannot be sent to the appropriate remote 
destination, the file will be stored in the ‘Unsent’ folder.
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Table view

The table view (on the right side of figure 29 on page 79) displays the file 
names of the files in the opened destination or temporary folder. 

Each file has the following information:
■ Name
■ Size
■ Type
■ Modified
■ Resolution
■ Image size.

If the currently viewed destination is the one you are scanning to, then the 
scanned file will appear at the end of the table. If you currently view another 
destination than the one you are scanning to, then the scanned to destination is 
displayed bold.

It is possible that there are more files in the table than fit on screen. The most 
recent scanned file appear at the end of the table. Under these circumstances it 
is possible that your most recent scanned file is not visible in the table on 
screen. In this case you can update the table view.

▼ Update the table view

1 From the ‘View’ menu select ‘Refresh’ or click the ‘Refresh’ button on the 
toolbar (see Figure 30). If the opened destination is also the one which is 
currently scanned to, then the view is automatically updated.

[30] The ‘Refresh’ button on the toolbar
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Actions in Océ Scan Manager

The Océ Scan Manager enables you to make settings for scan-to-file. You can 
edit and view the destination properties. You can also view the properties of 
scanned files.

Destinations

A destination is a location where you scan your file to. You can create, delete 
and lock destinations. You can also define automatic file naming to ensure your 
files get the desired names.

A destination can also be a file server or a PC of an end user. It is better to select 
remote destinations instead of the local ones. The local destinations are 
temporary and can only contain a limited number of scan files. Define the 
‘Scan memory reservation’ in the Océ Settings Editor (see ‘Find system 
settings in the Settings Editor’ on page 139). See the on-line help on the Océ 
Settings Editor for more details.

▼ Create a local destination

1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the 

toolbar (see Figure 31).

[31] ‘New’ button on the toolbar
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[32] ‘Destination properties’ window

3 Enter a logical name for the destination in the ‘Name’ text box.
This logical name also appears on the scanner panel (see Figure 24 on 
page 72).

4 Select the ‘On the controller’ type from the ‘Type’ drop-down list box.
5 Enter a path of the target folder in the ‘Path’ text box. You can also click the 

‘Browse’ button to select the path.
Note: This is only possible if you select ‘On the controller’ as ‘Type’ (see 
step 4).

6 Click Ok to accept the destination properties.

▼ Create a network destination with SMB

1 Create a shared folder on a workstation. For example c:\Scan
2 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see Figure 31). 
The Destination Properties dialog box appears (see Figure 32)

3 Select SMB from the ‘Type’ drop-down list box.
4 Enter the system name of the workstation where you created the shared folder.

Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

5 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder.
For Windows 95/98® use the folder name. This is case sensitive.
Note: You can not Browse. Instead of entering the path name by hand, you 
can use the drop-down list box to select a shared folder available on the 
selected system.
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6 If you have set a username and a password for the shared folder on the 
workstation, then enter the username and the password in the required fields.

7 Set the required file naming properties
8 Click OK

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
then shows the contents of the new SMB destination.

▼ Create a web destination with FTP

1 Create a home directory and a subdirectory on a workstation. For example 
c:Ftp/Scan

2 Enable FTP on the workstation
3 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see Figure 31). 
The Destination Properties dialog box appears (see Figure 32)

4 Select FTP from the ‘Type’ drop-down list box.
5 Enter the system name of the workstation where you created the shared folder.

Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder.
For Windows 95/98® use the folder name. This is case sensitive.
Note: You can not Browse.

7 For access to the directory on the workstation through FTP, a user name and 
password is set on the FTP server that runs on the workstation. Enter this user 
name and this password in the required fields on the Destination Properties 
dialog box of the Océ Scan Manager.

8 Set the required file naming properties
9 Click OK

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
then shows the contents of the new FTP destination.

Note: You can create a maximum number of 10 destinations.
Note: Names in Japanese can only be entered for remote destinations in 
SMB.
A key operator can determine whether a destination can be modified by an 
anonymous user. This done by locking and unlocking a destination.

▼ Lock a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Check the ‘Locked’ check box.
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4 Click Ok to accept the destination settings.
The destination properties are now locked.
Note: This option is only available if you are logged on as a Key operator (see 
‘User modes’ on page 163).

▼ Unlock a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Uncheck the ‘Locked’ check box.
4 Click OK to accept the destination settings.

The destination properties are now unlocked.
Note: This option is only available if you are logged on as a Key operator 
(see ‘User modes’ on page 163).

▼ Delete a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see Figure 33).

[33] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or 
as a Repro operator.

Note: You are not able to delete the last destination.

▼ Set / Change destination properties

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see Figure 34).

[34] ‘Properties’ button on the toolbar

The ‘Destination properties’ screen appears as in figure 32 on page 83.
3 Change the destination properties as described in ‘Create a local destination’ 

on page 82.
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Define file names

You can define the file names in the following two methods. 

1 automatic file number definition for all originals in the scan-to-file job
2 manual file name definition per original in the scan-to-file job.

▼ Automatic file number definition

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.

The ‘Destination properties’ screen appears (see Figure 32 on page 83).
3 Enter a name in the ‘Base name’ text box.

Do not change the ‘###’ part, this part is used for automatic file name 
numbering. Océ Scan Logic replaces ‘###’ by an ascending number. You can 
put dots in the ‘Base name’.

4 Select or clear the check box ‘Add correct file extension’ to add or leave out 
the file extension. Set the file extension in the Océ Settings Editor.

5 Enter the start value for the automatic file naming in the ‘Start value for ###’ 
field.

6 Click ‘OK’ to accept the destination properties.
7 Scan the originals.

You can scan now with automatic file name numbering. Select the above 
destination on the scanner operator panel and set all scan-to-file properties. 
While you scan, the scanner operator panel displays the file name. The settings 
are active until a copy job interrupts the scan job.

▼ Manual file name definition

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.

The ‘Destination properties’ screen appears (see Figure 32 on page 83).
3 Select or clear the check box ‘Add correct file extension’ to add or leave out 

the file extension. Set the file extension in the Océ Settings Editor.
4 Enter a name in the ‘Base name’ text box.

Remove the ‘###’ part, this part is used for automatic file naming. You can put 
dots in the ‘Base name’.

5 Click ‘Apply’ to accept the destination properties.
The ‘Destination properties’ screen stays open and is ready for the next 
scan-to-file action after the current original is scanned.

6 Scan the original.
7 Repeat step 4, 5 and 6 for each original.
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Scanned files

The right pane of the Océ Scan Manager contains the scanned files and 
additional information about the files. You can view, print and delete these 
files. You can also view the file properties.

▼ View a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘View’ or click the ‘View’ button on the 

toolbar (see Figure 35).

[35] ‘View’ button on the toolbar

Océ View Station LT (see ‘Océ View Station LT®’ on page 92) starts up and 
displays the file.
When you enable ‘Automatic view’ on the Océ Scan Manager, Océ View 
Station LT starts up automatically after scan to file.

Note: When you scan to file the controller Océ View Station LT starts 
automatically, showing the result of the scan.

▼ Print a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Print’ or click the ‘Print’ button on the toolbar 

(see Figure 36).

[36] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the Océ 
Settings Editor.

▼ Delete a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see Figure 37).

[37] ‘Delete’ button on the toolbar.
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The selected file will be deleted.

▼ View properties of a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see Figure 38).

[38] ‘Properties’ button on the toolbar.
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The following window appears (see ‘‘Scanfile properties’ window’ on 
page 89):

[39] ‘Scanfile properties’ window

3 Click Ok to close the ‘Scanfile properties’ window.

▼ Automatically view a file after scanning

You can choose to view a file automatically after scanning:
1 Open the ‘System’ menu and select ‘Auto view’.

When you scan-to-file, Océ View Station LT will start automatically and show 
the scanned file.

Manage the temporary store

When you regularly scan originals to a file, many files are created in the 
temporary store. You can clean up the temporary store manually or 
automatically.

To manually delete  the files in the temporary store select the ‘Purge’ command 
from the ‘System’ menu.

To automatically delete  the scanned files from the temporary store, you must 
configure disk cleanup in the Océ TDS800 Settings Editor to use this option. 
(see ‘Find system settings in the Settings Editor’ on page 139).

How to retrieve scanned files

When you scan-to-file your files will be stored in the destination you set. This 
can be on the local controller or on a remote system. You can retrieve your files 
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from the local controller via File Transfer Protocol (FTP) (see Figure 40). Also 
if during scanning to a remote destination, something goes wrong, you can 
retrieve your files from the local controller.

Files scanned to a local destination are stored in the directory of the controller. 
You can retrieve your files from the local host via File Transfer Protocol (FTP). 
FTP can be done: 

1 via an internet browser
2 an FTP application, or
3 via a command line prompt.

[40] How to retrieve scan files

▼ Retrieve files via an FTP command line prompt

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box now appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Océ 

Power Logic® Controller or the IP address (for example: 194.2.66.146) to 
connect to the Controller and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3 you could also enter “ftp 
host_name” in the FTP client.
The connection with the Controller is now established and a window appears 
asking you for a user name.
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4 Enter your user name ‘anonymous’, and enter as your password also 
‘anonymous’. 
A connection is now set up for the default user ‘anonymous’.
Note: As there is no registered user, you can simply press Enter to initiate 
the connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
7 Go to the ‘scan’ directory if you want to retrieve a file from a destination on 

the local host, 
or
go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder 
on the local host.

8 Get the data file (for example: bugatti.tif) via the ‘get’ command: 
‘get bugatti.tif’.
Quit FTP by entering the ‘bye’ command.

[41] The ftp directories on the Océ TDS800
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Océ View Station LT®

With Océ View Station LT you can view your scanned files. This can be 
automatic (see ‘Automatically view a file after scanning’ on page 89) after 
scanning or via Océ Scan Manager (see ‘Print a scanned file’ on page 87).

Océ View Station LT has the following menu’s (see Figure 42):
■ File
■ View
■ Preference
■ Help

[42] Océ View Station LT
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Menu options

File menu
Command What does it do

Close Closes the active document.

Properties Provides information about the scanned document. Allows the 
operator to change certain properties of the document.

View menu
Command What does it do

Fit Scales the image to fill the window.

1:1 Displays the image at a 1:1 scale factor.

Magnify Zooms into the page.

Reduce Zooms out of the page.

Refresh Redraws all windows displaying the active document.

Invert Reverses the black and white parts of the image.

Mirror Mirrors the image.

Rotate 90 CCW Rotates the image 90 degrees counter-clockwise.

Rotate 90 CW Rotates the image 90 degrees clockwise.

Rotate 180 Rotates the image 180 degrees.

Sample When active, displays only a sample of bilevel raster pixels.

Negate Reverses the raster image pixels on display and changes which are 
dominant for scaling. 

Scale to gray When active, displays the active bilevel raster image as though it 
were a greyscale image. 

Monochrome An image or screen having only background and foreground 
colors. Same as black-and-white or bilevel.

Preference menu
Command What does it do

View ribbon View Ribbon displays and removes the ribbon that contains 
buttons. The View Ribbon appears, by default, below the menu bar. 
It serves as a fast means of selecting some File, View, and 
Preference menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of the 
Océ View Station LT window. The Status Bar displays the pointer 
co-ordinates and a status line.
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Function buttons

Below the menu’s there are function buttons in a ribbon. This ribbon can be 
turned on and off (see ‘View ribbon’ on page 93). 

[43] Function buttons in Océ View Station LT

Figure 43 displays the buttons:
1 Invert: Reverses the black and white parts of the image.
2 Fit: Scales the image to fill the window.
3 1:1: Displays the image at a 1:1 scale factor.
4 Magnify: Zooms into the page.
5 Reduce: Zooms out of the page.
6 Mirror: Mirrors the image.
7 Rotate 90 CCW: Rotates the image 90 degrees counter-clockwise.
8 Rotate 90 CW: Rotates the image 90 degrees clockwise.
9 Rotate 180: Rotates the image 180 degrees.

10 Measurement When active, allows you to measure lines and areas on the 
image.

11 Reference. This small floating window displays the entire current page in 
miniature for reference.

12 Displays or removes the Detail window.

Reference Reference displays or removes a small, usually floating window. 
This window displays the entire current page in miniature. The 
crossed box inside the Reference window indicates which part of 
the page is displayed in the document window.
By moving or resizing the crossed box, you change which area of 
the page is displayed.

Detail Displays or removes the Detail window.

Measurement When active, allows you to measure lines and areas on the image.

Help menu
Command What does it do

About Shows information about Océ View Station LT.

Preference menu (continued)
Command What does it do

2 3 4 5 6 8 9 10 11 121 7
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View error

When the memory is almost full it can occur that the viewer does not show the 
scanned file. Instead it shows a red border with a red cross (see Figure 44).

[44] Error view in Océ View Station LT
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Chapter 5
Special copy and scan jobs

This chapter contains a description of special jobs and 
describes how to improve the output quality.
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Non-standard size originals

The scanner of the Océ TDS800 automatically detects the width of the inserted 
original. For DIN sizes, for example, it detects whether the width is A0, A1, 
A2, A3, A4, 500 mm, or 700 mm. The Océ TDS800 system uses a memory 
table that contains all standard width - standard length combinations to predict 
the length of the original. The scanner also measures the real length of each 
original while it is transferred through the scanner.

Note: When you scan thick, thin or damaged originals or originals in a carrier 
sheet, it is recommended to use the output at the rear side of the scanner to 
ensure correct delivery (see ‘Define settings for the next original’ on page 61).

The scan width

To prevent the loss of information when you scan a non-standard original, you 
can select the ‘non-standard’ scan width. The scanned width will then be larger 
than the original width. It is also possible to define the scanned width and 
length yourself. 

▼ Define the scan width

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press ‘Scan width’ to select the required setting:

■ Standard. This option must be used to scan a standard-size original.
■ Non-standard. This option can be used to scan a non-standard original. The 

scanned width will be larger than the original width (to the next larger, 
standard size), to prevent information loss.

■ Numeric. Define the scan width with the arrow keys or the numeric keys.

[45] Selecting ‘Non-standard’ scan size
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The copy size

The copy width depends on the selected roll and the custom defined scan 
width. The copy length depends on the selected cut option.

▼ Copy non-standard size originals

1 Select ‘auto roll’ on the printer operator panel.
The scanner scans wider than the original. No information is lost.

2 Open the ‘Sheet’ card in the ‘Print’ section on the scanner operator panel (see 
Figure 46).

3 Press the ‘Cut length’ function key to select the required cut option:
■ Standard, the print length corresponds to a standard format, depending on the 

media width. When you use ‘Standard cut’ information loss can occur.
■ Synchro, the system cuts at the measured length of the original times the 

zoom factor. The minimum length is 279 mm or 11 inch. When you use 
‘Synchro cut’ information loss will not occur. 

■ Custom (numeric), which cuts copies on a specified length. You can define 
the copy length yourself, using the arrow keys or the numeric keys.

4 Feed the original
5 Press ‘Start’.

[46] Define the cut length
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Scanning originals with filing strip
Left hand side  You can adjust the original guide of the scanner to remove a 
filing strip along the left hand side (in the feed direction, face-up). This side 
can be reduced by up to 60 mm (see Figure 47).

[47] Example of adjusting the left hand side of an original

▼ Copying with removed filing strip along the left hand side

1 Press the handle underneath the original guide, and move it to the right.

[48] Adjusting the original guide to add or remove a filing strip along the left hand side

2 Make all required settings.
3 Insert the original face up, left aligned with the original guide on the original 

feed table.

Right hand side  You can also remove the filing strip along the right hand side 
(in the feed direction, face-up) by selecting a specific roll. If the paper width 
of the original is larger than the paper width of the selected roll, the remaining 
part on the right hand side will not be scanned.

Left hand side
- 40 mm

Left hand side
+ 20 mm
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▼ Copying with removed filing strip along the right hand side

1 Select one of the roll selection keys on the operator panel.
2 Select the 100% key.
3 Make sure the ‘auto zoom’, ‘auto roll’, and ‘Scan width’ are not selected.
4 Make other settings as required.

Feed the original.

Leading and trailing strip  It is possible to adjust the length of both the leading 
and trailing strip to eliminate or add a filing strip. Leading and trailing strips 
can be extended up to 400 mm or shortened up to 400 mm (see Figure 49).

[49] Example of adjusting the leading and trailing strip of an original

Leading strip
-400 mm

Leading strip
+400 mm

Trailing strip
-400 mm Trailing strip

+400 mm
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▼ Copy with removed filing strips along the leading and trailing strip

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press the ‘Remove strip’ function key.

[50] Removing strip

3 Adjust the values for the trailing strip using the numeric or arrow keys.
4 Press the ‘Remove strip’ function key again.
5 Adjust the values for the leading strip using the numeric or arrow keys.
6 Make other settings as required.
7 Feed the original.

▼ Copy with added filing strips along the leading and trailing strip

1 Open the ‘Layout’ card in the ‘Print’ section.
2 Press the function key ‘Add strip’ function key.

[51] Adding strip

3 Adjust the values for the trailing strip using the Numeric or Arrow keys.
4 Press the function key ‘Add strip’ again.
5 Adjust the values for the leading strip using the Numeric or Arrow keys.
6 Make other settings as required.
7 Feed the original.



Special copy and scan jobs 103

The image quality

Improve the image quality by modifying the exposure, or by making use of 
special functions like automatic background compensation or setting the type 
of image you want to copy. 

Brightness

You can change the brightness of a print or copy by modifying the exposure of 
the scanner. The exposure can be set to lighter and darker.

▼ Set the exposure

1 Press the Up and down keys next to the exposure indicator on the scanner 
operator panel to adjust the exposure.

[52] The exposure keys and the exposure indicator
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Automatic background compensation

The automatic background compensation will provide a good quality output 
from a large variety of originals. The automatic background compensation 
setting ensures the production of background-free output of most line 
drawings. 

[53] Image settings

▼ Set the automatic background compensation

1 Open the ‘Image’ card in the ‘Original’ section.
2 Press the ‘Background compensation’ function key if this function is disabled.

When you scan extremely light or dark originals, or originals with uneven 
background density, the result may not meet your requirements (e.g. too much 
background). In such cases you can manually adjust the brightness (see 
Figure 52).

Original type  The Océ TDS800 Scanner allows you to adjust the exposure 
setting according to the type of image on the original. There are five original 
types available. Select a suitable mode according to the original (see Figure 53 
on page 104).
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▼ Set the original type of your image

1 Press the ‘Original type’ function key to select the appropriate image type:
■ Press the ‘Original type’ function key to select ‘Lines / text’. Use ‘Lines / 

text’ for originals which contain characters and line art. By default ‘Lines / 
text’ is selected with ‘Background compensation’ enabled.

■ Press the ‘Original type’ function key to select ‘Photo’ for the enhanced 
photo mode for originals which contain photographic matter. Use ‘Photo’ for 
originals which contain picture images.

■ Press the ‘Original type’ function key to select ‘Greys&lines’ when the 
original contains many greyscales and lines. Use ‘Greys&lines’ for GIS 
originals and maps.

Note: ‘Background compensation’ is turned off for ‘Photo’ and 
‘Greys&lines’.

■ Press the ‘Original type’ function key to select ‘Printed matter’. Use ‘Printed 
matter’ for printed originals containing a raster, for example coming from 
offset printing. ‘Printed matter’ eliminates the Moiré effect.

■ Press the ‘Original type’ function key to select ‘Blueprint’ when you want to 
scan an original with an image in ‘negative’ (image in white on dark 
background). The output will be ‘positive’ (image in black on white 
background).

■ Press the ‘Original type’ function key to select ‘Dark original’ when the 
original has an extremely dark background (i.e. low contrast).

■ Press the ‘Original type’ function key to select ‘Cut & paste’ when the 
original contains paste edges.

2 Make other settings as required.
3 Feed the original.
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Editing functions

The Océ TDS800 Scanner has editing functions. You set the functions before 
you scan the original.

Note: You can select only one edit function at a time.

Auto align

To align the image automatically to a side of the print you can use the 
alignment functions of the Océ TDS800 scanner. Alignment is possible in the 
following ways (see Figure 54):

[54] Auto align options with standard cut option active

Top Left Top Middle Top Right

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right
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▼ Select default settings for auto shifting with standard cut option

You must enable standard cut length to get output like the one in the example 
of illustration 54 above. With ‘Standard cut’ the print length corresponds to a 
standard format, depending on the media width. When you use ‘Standard cut’ 
information loss can occur.

1 Open the ‘Layout’ card in the ‘Copy’ section.

[55] Automatic shift with the ‘Align’ function

2 Press the ‘Align’ function key and select a horizontal alignment value (Left, 
Middle or Right) with the Arrow keys.

3 Press the ‘Align’ function key again and select a vertical alignment value (Top, 
Middle, or Bottom) with the Arrow keys.
Note: If you select ‘Middle’, make sure the original width is properly 
specified as described in the section about ‘The scan width’ on page 98:
■ ‘Standard’ if a standard sized original is used
■ The exact original width (numeric) if a non standard sized original is used.

4 Feed your original.

You must enable synchro cut length to get output like the one in the example 
of illustration 61. With ‘Synchro cut’ the system cuts at the measured length of 
the original times the zoom factor. The minimum length is 279 mm or 11 inch. 
When you use ‘Synchro cut’ information loss will not occur.
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[56] Auto shift options with synchro cut option active

In ‘Shift the image’ on page 108 you can read how to define the exact place of 
your image on the page. 

Shift the image

In some cases the margin may be too narrow to accommodate filing strips 
without loss of information. To avoid this, you can shift the image in horizontal 
or vertical direction, as shown below.

[57] Example of shifting the image

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right

Top Left Top Middle Top Height
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▼ Shift the image

1 Open the ‘Layout’ card in the ‘Copy’ section.

[58] Image shift

2 Press the ‘Shift’ function key and select a horizontal shift value by pressing the 
numeric or arrow keys until the required distance is set to shift the image to the 
left or to the right.

3 Press the ‘Shift’ function key again and select a vertical shift value by pressing 
the numeric or arrow keys until the required distance is set to shift the image 
upwards or downwards.

4 Make other settings as required.
5 Feed the original.

Note: You can use horizontal and vertical shift at the same time.

Mirror image

With the Océ TDS800 Scanner you can make a mirror image copy of an 
original, as shown in the next figure:

[59] Example of a mirror-image copy
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▼ Make mirror image copy

1 Open the ‘Image’ card in the ‘Print’ section.

[60] Mirror image

2 Press the ‘Mirror’ function key to enable the ‘Mirror’ function.
Make other settings as required and feed the original.
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Make a set copy

Set copy is an input mode which enables you to make one job out of multiple 
originals. It is distinguished from the ‘Multiple sheets’ input mode by the way 
the job is sorted. See page 58 for a description of the input modes.

▼ Make a set copy

1 Open the ‘Feeding’ card in the ‘Original’ section.
2 Use the ‘Input mode’ function key to select ‘Set‘.
3 Make other settings as required and feed the original.
4 Press the green Start key to start the copy job.

Your original is fed into the scanner. The printer starts.
5 Feed the other originals that make up your set.

When ‘Automatic feed’ is enabled, you do not have to press the green Start key 
everytime you feed an original.

6 When all originals are scanned, press the green Start key to close the set.
7 When you want to abort your job, press the red Stop key. When you press the 

red stop key, the entire job is deleted.
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Océ Matrix Logic® introduction

What is Océ Matrix Logic

Océ Matrix Logic® is an optional software application for Océ TDS800 
multifunction systems. It allows users to easily create different copy set 
outputs from one set of scanned originals.

Matrix Logic copying of a set is based upon storing the entire set of scanned 
originals (up to 100 documents) on the Océ Power Logic controller. You can 
then apply from 2 to 30 different configurations to that set. The result is that 
the output from the one set of scanned originals can be printed out up to 30 
different ways.

Enable matrix copying with a password in the Océ Settings Editor (see ‘Find 
system settings in the Settings Editor’ on page 139).

Workflow

Here are the steps to follow to compose and print a matrix job.

Note: Some steps are mandatory whereas others are only optional as 
mentioned below.

■ Launch Océ Matrix Logic
■ Scan a Matrix Job
■ Create a configuration (optional)
■ Define settings for the configuration (optional)
■ Save the configuration (optional)
■ Modify existing configurations (optional)
■ Compose an Océ Matrix Logic Job
■ Add configurations
■ Add banners
■ Print
■ Reprint
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[61] Workflow of Océ Matrix Logic®

One scan job is 
scanned in on the 
scanner.

Configurations 
are applied to the 
scan job.

The matrix copy 
jobs are sent to 
the printer.

The printer 
prints the 
matrix jobs
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Access Océ Matrix Logic®

Océ Matrix Logic can be accessed from the ‘Launcher’ window on the Océ 
Power Logic Controller graphical user interface:

Note: Océ Matrix Logic® can not be accessed via Océ Remote Logic.
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Use Océ Matrix Logic®

Matrix composition

From this tab, you can:

■ set ‘Job Level’ parameters (User name, User ID, Job name, Account ID)
■ view a list of the originals (up to 100 originals per job)
■ remove originals from the job
■ add, delete and manage pre-defined Copy configurations to apply to the 

Matrix job.
■ change settings to applied Copy configurations
■ select banners
■ initiate the Matrix job printing

Create a Matrix Job

▼ Launch Océ Matrix Copy

1 Using the 'Launcher' on the Power Logic controller graphical user interface, 
select Océ Matrix Logic.
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2 Click on the ‘Matrix composition' tab where the set of scanned originals is 
displayed.

▼ Prepare the Matrix job

1 Fill in the 'User name' and 'Job name' fields ('User ID' and 'Account ID' are 
optional).
Note: If your Océ TDS800 system has Océ Account Logging activated, then 
the 'User ID' and 'Account ID' will be stored by Océ Account Logging. 

2 Every original in the set that you scanned is assigned a name by Océ Matrix 
Logic®.
■ To remove a specific original from the matrix job, highlight that original by 

clicking on its name, and then click 'Remove'. 
■ To remove all the originals from the matrix job, click 'Remove all'.

▼ Scan your Matrix Job originals

1 Open the 'Original' section on the scanner-operating panel.
2 Select 'Feeding' card.
3 Once the feeding card is open, use the 'Input mode' button to select 'Matrix 

copy'.
Note: After you select Matrix copy, the 'File' and 'Print' sections as well as 
the 'Legend location' and 'Drawing method' cards on the scanner panel are 
disabled):

[62] Input mode with Matrix copy selected

4 Scan your entire set of originals (up to 100 originals), and remember to press 
the green start button to close the set when you are done.

Add configurations

You can add predefined copy configurations to your Matrix Job. These 
configurations are created in the ‘Copy configurations’ tab (see ‘Copy 
configurations’ on page 119).
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▼ Add configurations to your Matrix Job

1 Click ‘Add’ in the ‘Matrix composition’ window. The ‘Select a copy 
configuration’ window appears:

2 Select one or several configurations to apply to the job (up to 50).
3 Click ‘OK’:

The ‘ Matrix composition’ window now contains the configurations selected 
for the matrix job. The user may want to make changes to any particular 
configuration selected for this job. This can be done in the edit window.
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▼ Modify configurations from the Matrix Composition window

1 From the Matrix Composition section, highlight the configuration to modify. 
The settings are displayed.

2 Click the setting to modify. The value of the setting is displayed in the ‘Edit’ 
field.

3 Change the value.
4 Repeat steps 2 and 3 for every setting to modify.

Note: When editing a configuration, the change is not permanent. The 
original settings for that configuration are not changed. They are only 
changed for the Matrix job being printed at that time.

5 Print the Matrix Job (see ‘Print the Matrix job’ on page 118).

Print the Matrix job

▼ Print the Matrix job

1 Click ‘Print’.
2 Click the ‘Submission queue’ tab to follow the submission status:

■ Current job: displays the progress bar of the job being processed.
■ Pending jobs queue: displays the list of jobs that are pending to be submitted 

(busy printer).
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■ Submitted jobs queue: displays the list of jobs that have been submitted to 
the printer.

3 Click ‘Remove’ or ‘Remove all’ or ‘Delete’ if you want to remove one or 
several matrix jobs while they are pending or submitted.

4 Click ‘Move up’ or ‘Move down’ in the Pending Jobs queue if you want to 
change the print order.

Reprint

▼ Reprint the Matrix job

1 From the Submitted jobs queue, select the Matrix job.
2 Click ‘Print’.

Copy configurations

Copy configurations are pre-programmed copy settings. These settings are 
applied to the originals in the matrix job. Users can create and save up to 50 
different configurations:
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The left side of the Copy configurations tab has the configuration list. This 
shows all currently saved configurations. Users can create and save up to 50 
different configurations. Configurations may be edited when applied to a 
particular matrix job.

The right side of the screen shows the settings list. These are the available 
settings that can be stored in a configuration. Using the settings list is similar 
to using the Settings Editor of the Power Logic controller.

From this tab, you can manage the configurations:

■ create or delete a configuration
■ define or modify settings.
■ save the changes
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Edit configurations

▼ Create a new configuration

1 Click 'Create'. A default name is added in the configurations list:

2 Rename the configuration.
3 Type 'Enter' to validate.
4 Define the settings to apply to the configuration (see ‘Edit settings’ on 

page 122).
5 Click 'Save'. Successful saving is confirmed with a message.

Note: If you exit the tab without saving the changes in the configuration, a 
message asks you whether you want to save, discard or cancel the 
configuration.
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▼ Edit settings

1 Select a configuration in the list.
2 Select the setting to define or modify. The setting is displayed in the Editing 

zone.
3 Select the value to apply to the setting from the scrolling list.
4 Repeat steps 2 & 3 with all the settings to edit.
5 Click 'Save'.

▼ Delete a configuration

1 Select a configuration in the list.
2 Click 'Remove'.
3 Save.

▼ Save changes

1 Whatever the changes you apply to configurations (Delete, create, edit 
settings), you need to save the changes.

2 Click 'Save' to confirm the changes.
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Banners

Banners are extra informative pages added to a job. They list a number of 
attributes that are set in the Banner Selection Page (company name, logo). 

▼ Define a banner

1 From the Matrix Composition view, click ‘Banners’. The Banner selection 
page is displayed:

2 Check the ‘Enable banner’ option.
3 Define the banner settings:

■ Template name: Select a banner template.
■ Media source: select Automatic or Roll or Tray
Note: When you select roll or tray, an extra field is displayed to select the 
roll or tray number.
■ Notes: You can insert notes to your banner in this window. Notes are 

persistent from one job to another.
■ Enter a company name
■ Company logo: click the ‘Load’ button to load your company logo.

4 Click ‘OK’ to apply the defined banner to the job.
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Chapter 6
Océ Power Logic®: Settings Editor

This chapter gives information about the Océ Settings 
Editor. For details about specific settings refer to the Help 
on the Océ Settings Editor.
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Introduction

Use the Océ Settings Editor to set the default settings of the Océ TDS800 
according to your companies requirements. 2 types of users can determine 
settings in the Océ Settings Editor, Key Operators and System Administrators. 
You can log on as either Key Operator or System Administrator. Key Operators 
and System Administrators have different rights to determine settings.
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Overview of the Océ Settings Editor

The Océ Settings Editor is one of the controller applications for the Océ 
TDS800. The Océ Settings Editor allows users and operators to view settings 
of the system. If authorised, the settings of the system can be modified on the 
Océ Settings Editor.

With the Océ Settings Editor two groups of settings can be configured:
■ Key Operator settings (KO settings)

The Key Operator settings allow authorised users to configure default 
settings for the copy jobs, the scan-to-file jobs and the print jobs, default 
off-line fold settings and scan to file options. With the Key Operator settings 
also the printer, system and scanner defaults can be set or modified. A subset 
of the Key Operator settings are the Repro Operator settings. The Repro 
Operator has no rights to change settings in the Océ Settings Editor. In the 
Océ Queue Manager and the Océ System Control Panel the repro operator 
has the same user rights as the Key Operator and System Administrator. See 
‘User modes’ on page 163.

■ System Administrator settings (SA settings) 
The System Administrator settings allow authorised users to configure 
default printer language (PDL) settings and printer pen settings. It also 
allows the System Administrator to configure system and connectivity 
settings.

Note: Toggle between the display of Key Operator settings and System 
Administrator settings in the ‘View’ menu of the Océ Settings Editor.

Setting dependencies  The Océ Settings Editor is used to display and edit a 
specified group of settings. Some settings are related to other settings. If you 
want to change settings which have dependencies with other settings you will 
be prompted with a message. When a setting is changed, the system 
automatically updates the related settings. 

When you change certain settings, like measurement unit or paper series, all 
related settings are converted to the new setting (with a bullet for the settings 
that are changed).
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[63] Océ Settings Editor

General structure

The Océ Settings Editor is structured as follows: 
■ Menu bar
■ Top toolbar
■ Left toolbar
■ Settings area
■ Status bar
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Menu bar

The menu bar of the Océ Settings Editor contains the following menus:   

File   If you select the ‘File’ menu you can log on as a particular type of user, 
log off from the previously selected user mode, open an existing setting file, 
save the current settings to a file, connect to a different controller (only for 
remote users) or exit the Océ Settings Editor.

Edit  If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in 
which you can view your default system and the display languages (first and 
second) for the Océ Settings Editor application. The ‘Automatic logon’ option 
allows you to start the Océ Settings Editor application automatically in the 
specified user mode.

View  The ‘View’ menu allows you to switch between the display languages as 
defined in the Edit options window and to toggle between KO settings and SA 
settings. 

Help  The ‘Help’ menu contains the following options:  ‘Contents of Settings 
Editor’ and ‘About Settings Editor’.

[64] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons: 
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

[65] Top toolbar

Open  When you click on the ‘Open’ button, you open a saved file. 

Save as  All Key Operator and System Administrator settings can be saved in 
a file. This way you can have different settings for different customers, 
departments or other situations.
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Note: These settings can only be saved in Key Operator or System 
Administrator mode.

Apply  When you click on the ‘Apply’ button, the changes you have made 
become effective. Initially, this button is disabled. It is enabled after the first 
setting is changed and disabled again after the apply action is performed or 
after an undo action. 

Undo  This button restores the settings to the state it was in the last time the 
settings were applied (and not back to the factory default). Initially, the ‘Undo’ 
button is disabled. This button is enabled the moment the first setting is 
changed. It is disabled after an apply action is performed or after an undo 
action

Left toolbar

There are four different buttons available at the left toolbar of the Océ Settings 
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button 
provides access to a specific group of settings. By clicking on each of these 
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[66] Left toolbar
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Settings area

The settings area consists of two parts: a setting tree and an update area.

Tree structure  Most settings are displayed using a tree structure. By clicking 
on the settings, folders can be opened to show all the entries or closed to hide 
all the entries below these folders.

The settings for system components that are not available are not displayed. 
So, if you do not have a folder, no folder settings are available. This means that 
different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a 
bullet.

Update area  Select a setting in the tree structure. Edit the setting in the update 
area.

Note: If the user is not authorised for a particular setting, the update area is 
grayed out and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from 
the tree structure, but are accessed directly from the settings area.

The update area contains some additional information about the selected 
setting. This includes a brief description of the setting, as well as the minimum, 
maximum and default values (if applicable). 

[67] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information 
(left to right):

■ System status (icon for connected or disconnected)
The following icons are used:  

The Océ Settings Editor is connected to a system. 

The Océ Settings Editor is not connected to a system.

■ System name (‘localhost’ if you are working at the controller)
■ User mode (Repro operator, Key Operator, System Administrator or 

anonymous)
■ View mode (KO settings or SA settings).
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Use the Océ Settings Editor

Key Operator settings

The Key Operator is responsible for correct default settings of the system. 
These settings include the default settings, and groups of default printer 
settings for the print jobs, the scan-to-file jobs and the copy jobs.

The Key Operator can define all timer settings, like the panel time out and the 
sleep mode time out.

Note: Only one Key Operator or System Administrator can log on to the Océ 
Settings Editor at a time.

In order to perform special Key Operator functions, you must log on to the Océ 
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: When you are finished, make certain you log off from the Key Operator 
mode of the Océ Settings Editor to prevent unauthorized use of the Océ 
TDS800.

▼ Make Key Operator settings in the Océ Settings Editor

1 Maximise the Océ Settings Editor on the screen.
2 log on as Key Operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the defaults for the Custom card, are made 
directly from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting
Log off from log off the Key Operator mode when you have finished updating 
the settings.
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System Administrator settings

The Océ TDS800 System Administrator is responsible for: 

■ Dithering matrix and Poker settings
■ Printer language controller settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings. 

Note: Poker stands for Portable Kernel. Poker performs automatic 
interpretation of the host language in which the data from the scanner or in the 
job ticket is encoded. Poker makes sure that the quality between the input from 
the printer driver or scanner and the output from the printer is consistent. 
Poker supports data compression for scan-to-file and changes raw data from 
the scanner into high level file formats.

To modify the System Administrator settings you have to access the SA 
settings in the Océ Settings Editor.

There are two categories of System Administrator settings (see Figure 68):

■ Printer
■ System

.

[68] System Administrator settings in the Settings editor
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In order to perform special System Administrator functions, you must log onto 
the Océ Settings Editor as a System Administrator (see ‘User modes’ on 
page 163).

Note: When you are finished, make certain you log off from the System 
Administrator mode of the Océ Settings Editor to prevent unauthorized use of 
the Océ TDS800.

▼ Make System Administrator settings in the Océ Settings Editor

1 Maximise the Océ Settings Editor on the screen.
2 log on as System Administrator. 

See ‘User modes’ on page 163 for more information about logging into the 
Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the default pen settings, are made directly 
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 log off from the System Administrator mode when you are finished updating 
settings.

Access the Océ Settings Editor

In order to perform special Key Operator functions, you must log on to the Océ 
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: Only one user at a time is allowed to log on as a user authorised to 
modify setting (Key Operator, System Administrator, Service Engineer). When 
a second user tries to log on, an error message is displayed. Multiple users at 
a time are allowed to view settings. 
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Start the Océ Settings Editor

You can run the Océ controller applications on the controller as well as on a 
remote workstation

Note: Océ Scan Manager only runs local on the controller.

▼ Start Océ Settings Editor on the Océ Power Logic® Controller

1 Select the 'Launcher' application.
2 Select Settings Editor. Océ Settings Editor starts.

▼ Start Océ Settings Editor on a remote workstation

Note: You must first install Océ Remote Logic® as described (see 
‘Installation procedure for Microsoft® Windows systems’ on page 157).

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select the 'Launcher' application.
3 Select Settings Editor. Océ Settings Editor starts.

Define the contents of the custom card

Use the custom card to provide direct access to the frequently used settings.

▼ How to open the custom card editor

1 Click the ‘Jobs’ button in the left toolbar.
2 Click the ‘Copy & File’ tab in the settings area.
3 Select ‘Custom card’ in the tree structure.
4 Click the ‘Edit’ button in the update area.

The ‘Custom card editor’ displays.

▼ How to add settings

1 Open the ‘Custom card editor’.
2 Select the settings group in the ‘Setting groups’ list.
3 Click the right arrow button to move the selected setting group to the ‘Custom 

card’ list. The maximum number of setting groups that can be added to the 
‘Customer card’ list is five.

4 Select the settings group in the ‘Custom card’ list.
5 Click the up or down arrow buttons to change the order of the setting groups in 

the ‘Custom card’ list.
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6 Click the ‘Close’ button.
7 Click the ‘Apply’ button.

The ‘Custom card’ settings are now available in the custom section at the 
scanner operator panel (see ‘Custom section’ on page 49).

▼ How to remove settings

1 Open the ‘Custom card editor’.
2 Select the setting group in the ‘Custom card’ list.
3 Click the left arrow button to remove the selected setting group from the 

‘Custom card’ list.
4 Click the ‘Close’ button.
5 Click the ‘Apply’ button.

The ‘Custom card’ settings are now removed from the custom section at the 
scanner operator panel (see ‘Custom section’ on page 49).

Define the job templates

Use the job templates to define frequently used jobs.

▼ How to define the template name and description

1 Click the ‘Jobs’ button in the left toolbar.
2 Click the ‘Copy & File’ tab in the settings area.
3 Open a template in the tree structure.
4 Select ‘Template description’ in the tree structure.
5 Click in the text field under ‘Template name’ in the update area.
6 Enter the template name.
7 Click in the text field under ‘Template description’ in the update area.
8 Enter the template description.
9 Click the ‘Apply’ button.

The template name and description now displays on the scanner operator panel 
(see ‘Job templates’ on page 52).

▼ How to define settings in the job templates

1 Click the ‘Jobs’ button in the left toolbar.
2 Click the ‘Copy & File’ tab in the settings area.
3 Open a template in the tree structure.
4 Open the ‘Zoom’ menu in the tree area to access the zoom settings



138 Océ TDS800 User Manual

5 Open a card in the tree structure.
Open the ‘Original card’ to access the settings for the scanner input, the 
original.
Open the ‘Print card’ to access the settings for the printer output, the print.
Open the ‘File card’ to access the settings for the scan-to-file output, the file.

6 Open a submenu.
7 Select a setting in the tree area.
8 Change the setting in the update area.
9 Click the ‘Apply’ button.

The settings of the job templates are now available at the scanner operator 
panel. 
The ‘Original card’ settings are available at the original section (see ‘Original 
section’ on page 50).
The ‘Print card’ settings are available at the print section (see ‘Print section’ 
on page 51).
The ‘File card’ settings are available ate the file section (see ‘File section’ on 
page 51).

Manage different system adjustments with save and load

Use the save and load button to manage the different system adjustments for 
the customers, departments or other situations. Save stores all settings, the 
custom card and job templates included.

The Océ TDS800 has the following special files for your use.

■ Backup.kos/Backup.sas 
These files contain the previous values for the key operator settings and the 
system administrator settings before the last apply.

■ Current.kos/Current.sas 
These files contain the values for the key operator settings and the system 
administrator settings after the last apply.

▼ How to save all settings to a file

1 From the ‘File menu’, select ‘Save as’.
You can also click the ‘Save as‘ button on the top toolbar.
If the client is a local client, the screen displays a dialog box. You can enter a 
file name. The file is saved in the specified directory on the system.
If the client is a remote client, the screen displays a dialog box. You can enter 
a directory name and a file name.
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2 Enter the filename without .kos or .sas.
3 Click the ‘Save’ button.

Note: all settings, key operator and system administrator included, are saved.

▼ How to load KO or SA settings from a file

1 From the ‘File’ menu, select ‘Open’.
You can also click the ‘Open’ button on the top toolbar.
The screen displays a dialog box from where you can browse to the required 
file.

2 Click the ‘Apply’ button.
The settings are loaded to the system.
When you are logged on as a key operator, the system only loads the KO 
settings.
When you are logged on as a system administrator, the system only loads the 
SA settings.
Repro operators and anonymous users are not authorised to load the settings 
from a file.
Note: this is only possible if the user is logged in as a Key Operator or System 
Administrator.

Find system settings in the Settings Editor

The following table displays all references in this manual that refer to a 
Settings Editor setting. KO indicate that you must have Key Operator 
permission to change the setting. SA indicates that you must have System 
Administrator permission to change the setting. Open the ‘File’ menu and 
select ‘Logon’ to logon as Key Operator or as System Administrator (see 
Figure 64 on page 129).

System setting Reference 
on

Path in Settings Editor

Low power mode timer page 25 KO - System - Timers - Sleep mode 
timer enable - Low power mode time- 
out

Sleep mode timer page 25 KO - System - Timers - Sleep mode 
timer
KO - System - Timers - Sleep mode 
timer enable

Shut off timer page 25 KO - System - Timers - Shut-off time 
out

Wake up timer page 25 KO - System - Wake up
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Panel language page 32
page 52
page 166

KO - System - Localisation - Display 
languages

Custom card settings page 49
page 136

KO - Jobs - Copy & File - Custom card
KO - Jobs - Copy & File - Template - 
Custom card

Job template settings page 52
page 137

KO - Jobs - Copy & File

Panel time out page 54 KO - Scanner - Timers - Panel time- 
out

Zoom factor steps page 60 KO - Scanner - Zoom steps
Stamping page 65 KO - Jobs - Stamp
Passwords page 40

page 70
page 112

KO - System - Enabling passwords

Scan clicks page 71 KO - System - Localisation - 
Measurement unit

Scan memory 
reservation

page 82 SA - Scan memory reservation

Manage temporary store page 89 KO - System - Disk cleanup - Scan 
spool cleanup

Set memory threshhold page 143 SA - Set memory reservation
Set copy priority page 149

page 151
KO - Job priorities - Copy priorities

History queue job 
settings

page 149 KO - System - Job management - 
History queue

Folder drawing method page 179 KO - Jobs - Print - Defaults - Finishing 
- Drawing method

A4 Reinforcement page 184 KO - Printer - Folder reinforce A4

System setting Reference 
on

Path in Settings Editor
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Chapter 7
Océ Power Logic®: System 
Control Panel

This chapter describes how to view the status of the Océ 
TDS800 system on the Océ System Control Panel.
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Introduction

The Océ System Control Panel (SCP) application provides you with status 
information about the system. This includes:
■ Machine status of the printer
■ Overview of the loaded media types and sizes
■ Machine status of the scanner
■ Status of the system
■ Memory usage.

Note: If you do not have a scanner, the scanner status is not available. If you 
have a scanner only, the machine status of the printer and the overview of the 
loaded media is not available. 

Structure

The Océ System Control Panel window is divided into the following parts (see 
Figure 69 on page 144):

The menu bar  which contains the following menu’s:
■ File - Logon, Logoff, Connect to and Exit.
■ Edit

If you select this option a window is displayed in which you can view your 
default system for the Océ System Control Panel application. The Automatic 
logon option allows you to start the application automatically in the specified 
user mode.

■ View
The View menu allows you to switch between the display languages as 
defined in the Edit options window and to enable or disable Océ System 
Control Panel sub windows.

■ System
The System menu allows you to dump your configuration settings, make a 
demo print, clear the system and shut down the system.

Help options: Contents of Océ System Control Panel, About Océ System 
Control Panel.
■ Toolbar

The toolbar of the Océ System Control Panel contains the following buttons:
Printer: to hide or to show the status of the printer.
Media: to hide or to show media information.
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Scanner: to hide or to show the status of the scanner.
Controller: to hide or to show the status of the controller.
Memory: to hide or to show the amount of set memory that is used.

Note: If operator invention is required for a device, the respective button 
flashes.

The Printer status display  Displays the current status of the Printer. Any error 
messages displayed on the printer control panel also appear in the printer status 
window of the Océ System Control Panel.

The Media display  Provides graphical information about the status of the rolls 
and sheetfeeders (available, empty or disabled) of the printer and about the 
available media (size and type).

Note: If the Media type is polyester, the thickness is displayed in mail (0.001"), 
otherwise the weight is displayed in g/m2. 

When a roll or tray is disabled the roll or tray icon is dimmed and the media 
information is replaced by the text “-disabled-” (see ‘Icons’ on page 144).

Note: Special media are excluded from the automatic behavior of the Océ 
Power Logic® Controller.

The Scanner status display  Displays the current status of the scanner. Any 
error messages displayed on the scanner control panel will also appear in the 
scanner status window of the Océ System Control Panel.

The set memory meter  Indicates how much of the set memory is filled. The 
information is displayed in the form of a meter which is divided into three 
zones:
■ Green: safe, you have enough space left to print large jobs/many small jobs
■ Orange: pay attention, you might reach the set memory limit soon
■ Red: the set memory is (nearly) full; you should remove files or wait until 

files are printed and automatically removed or flushed from memory. No 
more print jobs are accepted. copy jobs can still be made.

Note: At the right of the set memory meter a percentage is displayed, indicating 
the amount of set memory currently being used.

Set the threshold values for the orange and red zones in the Océ Settings Editor 
(see ‘Find system settings in the Settings Editor’ on page 139).
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Below the Océ System Control Panel main window is displayed:

[69] Océ System Control Panel window

Icons

The Océ TDS800 Océ System Control Panel uses a number of icons to display 
information about the media available on the printer. The following icons are 
used:

The material is available and the roll is ready for printing.

The roll is disabled.

The roll is enabled but empty.

Access to
ial

Access to
Page

Interrupt
job
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User actions

The Océ System Control Panel allows you to perform the following actions:
■ Make a demo print
■ Print your system configuration
■ Clear the system
■ Shut down the system

▼ Make a demo print

1 Select the ‘Demo print’ option in the ‘System’ menu.
A demo print is made on the printer.

▼ Print your system configuration

1 Select the ‘Print settings’ option in the ‘System’ menu.
A list is printed of the current settings on the Océ Power Logic® Controller.

▼ Clear the system

1 Select the ‘Clear system’ option in the ‘System’ menu to delete all jobs. 
You can use this option in case of a corrupt job which can not be deleted with 
the help of the Océ Queue Manager. 
Note: This option is only available in repro operator, key operator and 
system administrator mode. In anonymous user mode it is not possible to 
clear the system.

▼ Shut down the system

1 Select the ‘Shut down’ option in the ‘System’ menu to shut down the system.
Note: In anonymous user mode it is not possible to shut down the system.
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Chapter 8
Océ Power Logic®: Queue 
Manager

This chapter describes how to view the Océ TDS800 System 
print queue, history queue and inbox queue. This chapter 
contains a description of how to manage jobs in the Océ 
Queue Manager.
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Introduction

The Océ Queue Manager application provides you with a graphical 
representation of the print queue. It allows you to view the print queue and the 
status of the print jobs as well as to manage the jobs in the queue. With the Océ 
Queue Manager you can:
■ Abort the job currently being printed
■ Delete jobs in the queue
■ Put jobs in the queue on hold
■ Print jobs from the history queue
■ Print jobs form the inbox queue
■ Move jobs to the top of the queue
■ Restart jobs that were previously put on hold in the queue

▼ Start Océ Queue Manager on a remote workstation

Note: You must first install Océ Remote Logic® in ‘Installation procedure 
for Microsoft® Windows systems’ on page 157.

1 Select 'Océ Remote Logic®' via the 'Start' menu, or
2 Select the 'Launcher' application.
3 Select Queue Manager. Océ Queue Manager starts.

Note: To start more than one Océ Queue Manager, Océ System Control 
Panel or Océ Settings Editor you can better use the Launcher.

Structure
The Océ Queue Manager window is divided into the following parts (see 
Figure 70 on page 150):

■ The standard menu bar.
The menu bar for the Océ Queue Manager contains the following menus:

■ File: ‘Logon’, ‘Logoff’, ‘Connect to’, ‘Close’
■ Edit: set the default printer and ‘Auto logon’.
■ View: selecting the language, switching between queues, and configuring the 

view of the queues.
■ Help: About Océ Queue Manager, Contents of the help,.
■ The toolbar

The toolbar for the Océ Queue Manager contains the following icons:
■ ‘Hold’, ‘Resume’, ‘Move to top’, ‘Delete’ and ‘Print’.
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■ The active print job window.
This window displays the job currently being printed on the Océ TDS800.

■ The print queue window.
This window has a tabular format and shows the jobs waiting to be printed. 
The jobs are displayed in the order in which they are expected to be printed.

Note: Set the copy priority setting in the Océ Settings Editor to have copy 
jobs take priority over print jobs (see ‘Find system settings in the Settings 
Editor’ on page 139). 
■ Inbox queue

The inbox queue contains print jobs which have been sent to the inbox on the 
controller. You can print these jobs, view the properties and delete these jobs.

■ History queue
The history queue contains print and copy jobs which have been printed. You 
can print these jobs, view, edit some the properties and delete these jobs. You 
can set how long and how many jobs are kept in the history queue, in the Océ 
Settings Editor (see ‘Find system settings in the Settings Editor’ on 
page 139).

Note: You can not view the history queue and inbox queue at the same time. 
Select either the history queue or the inbox queue from view menu on the 
toolbar. They will be visible in the right pane of the queue manager window.

Note: The Inbox queue and History queue are not active when advanced 
Queue Management is disabled

■ Status bar
The Océ Queue Manager has a status bar displaying the following 
information:

■ System status (connected, not connected)
■ The connected system
■ The job status e.g. ‘printing job.A0.hp’
■ User mode

For each job the following information is displayed:
■ The current status and schedule of the job in the form of an icon. See ‘Icons’ 

on page 152.
■ The name of the print job.
■ The type of job (print job / copy job)
■ The name of the user who has submitted the print job.
■ The number of sets and pages.
■ Any remarks (e.g. ‘Manual Feed’).
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You can resize the columns in the main queue window by dragging the table 
header separators. It is also possible to change the order of the columns by 
dragging a specific column to a new position.

Note: You can sort the inbox queue and history queue. You can not sort the 
printer queue.

[70] Océ Queue Manager window

menu bar

toolbar

header
separator

print  queue
window

status
bar

Inbox Queue
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Modes

The Océ TDS800 Queue Manager has the following modes: 
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode
■ Service operator mode

These different modes are designed to limit access to the specific functions to 
authorized users only. 

The anonymous user mode only offers view access of the queue. In this mode, 
the buttons and menu items are disabled.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of activities on the jobs in the queue, with the help of 
the Abort, Delete, Resume and Hold buttons. The service operator mode is 
intended for use by Océ technicians.

Note: In the Océ Queue Manager and the Océ System Control Panel, the repro 
operator, the key operator and the system administrator have the same user 
rights. In the Océ Settings Editor, however, the user modes offer different rights 
(see ‘Find system settings in the Settings Editor’ on page 139).

Access  The access to the key operator, repro operator, system administrator 
modes and service operator is password protected to allow only authorized 
personnel to use particular functions. You can enter these modes by selecting 
the Logon option from the File menu and by specifying the correct password 
when prompted for it, (see ‘Log on’ on page 164). 

From the ‘File’ menu, select ‘Close’ to exit the Océ Queue Manager.

Job priority  The priority of print and copy jobs in the Océ Queue Manager is 
determined by the order in which they are submitted to the Océ TDS800. 
However, there is a setting in the Océ Settings Editor which allows you to give 
copy jobs priority over print jobs (see ‘Find system settings in the Settings 
Editor’ on page 139).



152 Océ TDS800 User Manual

Icons

The Océ TDS800 Queue Manager uses a number of icons to display 
information about a job in the queue. The following icons are used:

[71] Receiving the job

[72] Received the job

[73] Processing / processed the job

[74] The job in progress

[75] Printing the job

[76] Delivering the job

[77] The delivered job 

[78] The deleted job

[79] A job that requires manual feed

[80] The job is placed on hold by the user or the system.

[81] Attention, needs operator attention (e.g. a media request).
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Managing print jobs

▼ View the print queue

The Océ Queue Manager displays all jobs sent to the print queue in a list sorted 
according to the order in which they will be printed. 

The order can be changed by: 
■ deleting jobs
■ putting jobs on hold
■ restarting jobs currently on hold
■ moving jobs to top (not when advanced Queue management is disabled)
This list will be automatically updated.

Note: Queue operations can only be performed when you are properly 
authorized. Before you can use the Océ Queue Manager in a different 
mode, you first have to enter a password to get the required access. See 
‘User modes’ on page 163.

▼ Deleting print jobs

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be deleted by clicking on the first 
job, holding down the Shift key and clicking on the last job. You can select a 
non-consecutive list of jobs to be deleted by clicking on each desired job while 
holding down the Ctrl key.
Note: To delete a job from a remote client, you need repro operator, key 
operator or system administrator rights.

2 Click on the Delete button. 
A cross icon is displayed in front of the job indicating it will be deleted. After 
the job is actually deleted, the job is removed from the queue. 
Note: Make sure you take this into account before you use the Delete button. 
A delete operation cannot be undone.
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▼ Putting print jobs on hold

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be put on hold by clicking on the 
first job, holding down the Shift key and clicking on the last job. You can select 
a non-consecutive list of jobs to be put on hold by clicking on each desired job 
while holding down the Ctrl key.

2 Click on the Hold button. 
A job that is put on hold will retain its position in the print queue. Once it 
reaches the top of the queue, the job that is put on hold will stay there until it 
is restarted or deleted. While a job is on hold, other jobs will be printed, even 
when they were behind the job on hold in the queue. The active job and the jobs 
in printing state can not be put on hold by the Océ Queue Manager.

▼ Restart jobs that are put on hold

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be restarted by clicking on the first 
job, holding down the Shift key and clicking on the last job. You can select a 
non-consecutive list of jobs to be restarted by clicking on each desired job 
while holding down the Ctrl key.

2 Click on the Resume button. 
The selected jobs are now restarted.

▼ Move jobs to top

Note: Not when advanced Queue Management is disabled.
1 Select the desired jobs by clicking on them. 
2 Click on the Move to top button on the toolbar.

If more than one job is selected then the first selected job will be on top, the 
second will be on top, the second below that one and so on.
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Chapter 9
Océ Power Logic®: Remote Logic

This chapter describes how to install and use Océ Remote 
Logic®.
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Introduction

Océ Remote Logic® enables you to:
■ View system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
■ Change settings (Océ Settings Editor).

Océ Remote Logic® has five different user modes (see ‘User modes’ on 
page 163). These user modes are meant to limit access to special functions to 
authorized users only. Log in to get access to one of the user modes.

Change the display language, to operate the Océ Remote Logic® in your 
language. Use the help system if you do not know how to work with the 
applications.

Océ Remote Logic® is available on the local host and as a remote version 
except for Océ Scan Manager which is only available on the local host.

The Océ Remote Logic® applications can operate separately. If you start the 
applications separately, you have to log on and select a language in each 
application. If you start the applications via the Application Launcher, the 
language is selected automatically.

Note: The default language is English UK
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Installation procedure for Microsoft® 
Windows systems

Before you install Océ Remote Logic®, you must take note of the following 
minimum system requirements for the remote system. The system must be a 
Pentium® 233 with 32 Mb RAM running Windows® 95, 98, NT® (service 
pack 3),Windows® 2000 or XP.

Océ Remote Logic® (Océ Queue Manager, Océ System Control Panel and 
Océ Settings Editor) are on the Océ TDS800 CD-ROM and on the Océ Power 
Logic Controller® CD-ROM provided with the system. The installation 
procedure for Océ Remote Logic® is quite simple and self-explanatory. When 
you select the ‘Install remote applications’ option on the CD-ROM, a Wizard 
starts to guide you through the installation process. When the installation 
process is complete you do not have to restart your system.

Note: Océ Remote Logic only works when TCP/IP is enabled on your system. 
Refer to your system administrator for assistance with the installation 
procedure for TCP/IP.
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▼ Install Océ Remote Logic®

1 Insert the Océ TDS800 CD-ROM or the Océ Power Logic® Controller 
CD-ROM into the CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option. 
The installation Wizard starts, and asks to select a setup language.

[82] Choosing a setup language

3 Indicate the required language and click ‘OK’. 
4 Follow the instructions on screen to complete the installation of ‘Océ Remote 

Logic®’.

The programs are now installed. Each application is installed separately and as 
part of a combined version called Application Launcher.

When the installation is complete, you can start the ‘Application Launcher’ by 
selecting them from the specified folder in the ‘Start’ menu. 

To work with the Application Launcher you first have to connect to an 
available Océ TDS800 machine. How to connect is described in ‘How to use 
the remote system’ on page 169.

If you plan to work with more than one of the available remote applications, 
you are advised to use the Application Launcher, because this uses less system 
resources than the individual applications.



Océ Power Logic®: Remote Logic 159

Installation procedure for Unix systems

Note: A system administrator must install ‘Océ Remote Logic®’ on a UNIX 
system.

Océ Remote Logic® is set up to be platform independent. It runs on a variety 
of operating systems providing that a Java™ runtime environment is available 
for that platform. The Java™ runtime environment must be installed by a user 
with system administrator privileges. It is also assumed that Océ Remote 
Logic® is installed by an experienced user.

General installation instructions

▼ Install ‘Océ TDS800 Remote logic®

1 Check if a Java™ runtime environment (JRE) is installed on the system. The 
preferred version is JRE 1.1.8. Below you can find some links to JRE's for 
various UNIX platforms.

2 Unpack the contents of the file ‘Océ Remote Logic_vX.tar’ to a subdirectory 
on the system. 

3 Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.
4 Set the environment variable ‘RL-VM-HOME’ to point to the installation of 

the JVM.

UNIX versions and the required JRE
UNIX version OS version JRE Default installation directory

IBM AIX 4.1.5 1.1.6 /usr/jdk_base

IBM AIX 4.2.1 1.1.8 /usr/jdk_base

IBM AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2

IBM AIX 4.3.3.10 + fix 1.3.0 /usr/jdk_java130

SUN Solaris® 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX 1.0 1.1.3

LINUX 1.2 1.1.8

Note: OS = Operating System, JRE = Java™ Runtime Environment
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5 Edit this file so that it points to the JRE of the system. (instructions are supplied 
in the file).

6 Save the file ‘clientstart’.
7 Run the file ‘clientstart’ with the applications as parameters. (e.g. clientstart 

QM SCP SE to start the three applications), or run ‘Application Launcher’ to 
start the applications, (alternately modify the file ‘clientstart’).

IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be 
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote 
Logic® is the 1.1.8 version.

HP-UX

For HP-UX 10.20 and 11.00 the runtime engine can be downloaded from: 
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 
environment 10.20 and HP-UX environment 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux which can be downloaded from: 
http://www.ibm.com/java
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Installation procedure for Apple 
Macintosh®

Apple also has a Java™ runtime environment for the Macintosh®. The Mac 
OS Runtime for Java™ (MRJ) can be obtained at: 
http://www.apple.com/

Installation instructions for Apple Macintosh® are not available at this time. 
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Use Océ Remote Logic®

Océ Remote Logic® enables you to:
■ View the system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
■ Change settings (Océ Settings Editor).

Océ Remote Logic® has five different user modes (see ‘User modes’ on 
page 163). These user modes are meant to limit access to special functions to 
authorized users only. Log in to get access to one of the user modes.

Change the display language, to operate Océ TDS800 in the language of your 
selection. Use the on-line help system if you do not know how to go on with 
the applications.

The Océ TDS800 applications operate separately. You have to log on and select 
a language in each application.

Start the Océ TDS applications via the ‘Start’ menu or via the Application 
Launcher application.

▼ Start Océ TDS800 on a remote workstation

1 Select 'Océ TDS800' via the ‘Start’ menu.
2 Select Application Launcher.
3 Select the required application. 
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User modes

The following user modes are available:
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode
■ Service operator mode

The anonymous user mode only offers monitoring capabilities. You are not 
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of user actions.

In the Océ Queue Manager and the Océ System Control Panel the repro 
operator, the key operator and the system administrator have the same user 
rights. The repro operator, the key operator and the system administrator 
modes allow you to perform a number of activities on the jobs in the queue, 
with the help of the Abort, Delete, Resume and Hold buttons. 

In the Océ Settings Editor, however, the user modes offer different rights. In 
repro operator mode, the operator is allowed to only view settings in the key 
operator and system administrator views. 

In key operator mode, the operator is allowed to view and change settings in 
the key operator view. The key operator is also allowed to view system 
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change 
settings in the system administrator view. The system administrator is also 
allowed to view key operator settings, but is not able to change them. 

The service operator mode is meant for the Océ technician.

When you are not authorised to perform a certain action, the action is grayed 
out.

Note: The status bar at the bottom displays the active user mode.
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Log on

The access to the key operator, repro operator, system administrator and 
service operator modes is password protected to allow only authorised 
personnel to use particular functions.

The default password for the System Administrator is: SysAdm.
The default password for the Key Operator is: KeyOp.
The default password for the Repro Operator is: ReproOp.
Note: The default passwords are case sensitive. Change the passwords after 
your first logon. 

▼ How to log on

1 From the ‘File’ menu, select ‘Log on’.
2 Select the correct user name.
3 Enter the Password. 
4 Click ‘OK’.

Note: Log on to all Océ TDS800 programs, to operate with all the 
applications.

Logon is restricted to one user only. When a second user attempts to log on an 
error message will appear (see figure below).

[83] When a second user attempts to log on an error message will appear

Log off

You have to log off to leave the key operator, repro operator and system 
administrator modes.

▼ How to log off

1 From the ‘File’ menu, select ‘Log off’.
You return to anonymous user mode.
Note: Log off from all Océ Remote Logic applications separately.
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To change the password

You can change your password on a standard base. You can change the 
password for each user mode (except anonymous user mode, for which no 
password is required and service operator) by taking the following steps:

▼ Change the password:

1 From the ‘File’ menu, select ‘Log on’.
2 Click the Password button. 
3 Select the correct user name in the ‘User name’ drop-down list box.
4 Enter the old password in the ‘Password’ text box.
5 Enter the new password in the ‘New password’ text box.
6 Enter he new password in the ‘Confirm new password’ text box and click ‘OK’ 

to confirm the new password.

Automatic logon

If you do not want to log on each time you start an application, you can select 
the automatic logon function. This option allows you to start an application 
automatically in the indicated user mode.

▼ Enable automatic logon

1 From the ‘Edit’ menu, select ‘Options’.
The Options window appears.

2 Select the ‘Enable automatic logon’ check box.
3 Select the correct user mode and enter your password for that user mode.
4 Click ‘OK’.

Automatic logon is now enabled.
Note: Enable Automatic logon in all four Océ Remote Logic applications 
separately.
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Language

From the ‘View’ menu, select ‘Language’, to select one of the supported 
languages. 

Note: The check mark in front of the language indicates that this is the active 
display language.

▼ Set the languages

1 From the ‘View’ menu, select ‘Language’.
To change the language in the scanner and printing operator panels, change the 
display language setting in the Océ Settings Editor.

Help

▼ Display help information

1 Open the ‘Help’ menu and select ‘Contents’. 
Here you find help information for all applications and functions of the Océ 
TDS800 applications.

Command line parameters

In order to start the remote applications faster, there are 6 command line 
parameters available.

configfile=<config_file>  Sets the configuration file to use.

server=server  Sets the specified server as the server to connect to.

language1=lang   Specifies the first language in combination with the 
parameter ‘country1=country’.

country1=country  Specifies the first language in combination with the 
parameter ‘language1=language’.

language2=lang  Specifies the second language in combination with the 
parameter ‘country2=country’.

country2=country  Specifies the second language in combination with the 
parameter ‘language2=language’.
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Note: You must always use a matching combination of ‘lang’ and ‘country’.

The parameters can be applied to the following applications:
■ QM.exe (Océ Queue Manager)
■ SCP.exe (Océ System Control Panel)
■ SE.exe (Océ Settings Editor)
■ Launcher (Océ Queue Manager, Océ System Control Panel, and Océ Settings 

Editor)

Note: These applications are usually located in ‘C:\Program Files\OceRemote 
Logic\Bin’.

The easiest way to do this is by creating a short-cut of an application and then 
add the command line properties.

Example command line parameter  Below is an example of how to start the 
Océ TDS800 applications with the configuration file ‘Myconfig.cfg’, 

Language parameters
Language parameter 

(lang)
Country

Danish da DK

Czech cs CZ

Spanish es ES

Finnish fi FI

Hungarian hu HU

Italian it IT

US English en US

UK English en GB

Dutch nl NL

German de DE

French fr FR

Portuguese pt PT

Norwegian no NO

Swedish sv SE

Polish pl PL

Japanese ja JP

Chinese 
Simplified

cn CN

Chinese 
Traditional

cn TW
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connected to the ‘MyTDS800’ server. The first language is set to US English 
and the second to French:
‘C\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg 
server=MyTDS800 language1=en country1=US language2=fr country2=FR’.
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How to use the remote system

Start up the Océ Remote Logic applications (Océ Settings Editor, Océ Queue 
manager, Océ System control panel), on a remote client after you installed the 
software (see ‘Installation procedure for Microsoft® Windows systems’ on 
page 157). In order to use the functionality you first have to add an Océ 
TDS800 system and then connect to an available Océ TDS800 system.

▼ Add an Océ TDS800

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear with a drop-down list box containing the already 
added Océ TDS800 systems. 

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address or the name of the Océ TDS800 system you want to 

connect to, in the ‘Systems’ text box.
4 Click ‘Add’. The system is added to the list. You can add as many systems.

Note: You can also remove an Océ TDS800 system. Select one in the list and 
click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ TDS800 system, the system has to be 
installed and configured by a system consultant or a technician.

▼ Connect to an Océ TDS800 system

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear containing a drop-down list box with the available 
Océ TDS800 systems. 

2 Select one of the available Océ TDS800 systems and click on ‘OK’. When you 
connect to another system, all settings have to be retrieved. This may take some 
time.
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Chapter 10
Océ Account Center

This chapter describes what Account Center is and how to 
use it.
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Introduction

Océ Account Center is an application used to manage the account information 
of print, copy and scan-to-file jobs. Océ Account Center consists of the 
following two applications:

■ Océ Account Logic.
Océ Account Logic requests the operator and the user to enter account 
information. The operator can enter the account information at the Océ 
Power Logic® controller for the copy and scan-to-file jobs. The user can 
enter the account information at the workstation for the print jobs. Océ 
Account Logic runs on the Océ Power Logic® controller and is available 
through your Internet browser (see ‘Océ Account Logic’ on page 173).

■ Océ Account Console.
Océ Account Console provides options for managing the account 
information. The system administrator uses the Océ Account Console to 
define the contents of the account information in the dialog boxes in the Océ 
Account Logic application. Océ Account Console runs on the workstation of 
the system administrator. Access to Océ Account Console application is 
password protected and limited to the system administrator (see ‘Océ 
Account Console’ on page 175).
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Océ Account Logic

Introduction to Océ Account Logic

Use Océ Account Logic to link account information to your job. The account 
information requirements are defined and managed by the system 
administrator. Use Océ Account Logic for the following:

■ Enter the account information for the print jobs
■ Manage print jobs that do not have valid account information
■ Enter account information for the copy and scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).

Océ Power Logic® controller setup

Before you begin to use Océ Account Logic, you must define the correct 
settings in the Océ Settings Editor.

System setting Reference on Path in Settings Editor
KO - System - Enabling 
passwords - Advanced 
Queue Manager

Use the correct 
password to enable the 
‘Advanced Queue 
Manager’

Advanced Queue 
Manager adds 
the‘Inbox’ feature to the 
Océ Queue manager. 
Océ Account Logic 
requires that you use 
the‘Inbox’.

KO - System - Enabling 
passwords - Account 
logging

Use the correct 
password to enable 
account logging.

Before you can use Océ 
Account Logic, enable 
account logging on  Océ 
Power Logic® 
controller
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Note: Please consult the Océ Account Center user manual and the on-line help 
in the application for detailed information.

KO - System - Job 
management - Print jobs

Select ‘Jobs in inbox’. Océ Account Logic 
requires that all jobs are 
send to the ‘Inbox’.

Note: The print jobs that 
have valid account 
information are 
automatically moved from 
the Inbox to the Print queue. 
Enter the account 
information for the print 
jobs that do not have valid 
account information on the 
‘Print’ tab of Océ Account 
Logic.

KO - System - Job 
management - Rights for 
printing

Select ‘Special user’. Océ Account Logic is a 
special user on the Océ 
Power Logic® 
controller.

KO - Scanner - Settings - 
Timers -  Panel timeout

Océ advises you to set 
the panel timeout to the 
minimum value (30 
seconds).

When the check box 
‘The scanner locks 
when the scanner panel 
timeout expires‘ is 
checked in the ‘Define 
the account information 
requirements for the 
jobs’ section of the 
administration window, 
the user is required to 
unlock the scanner for 
the copy jobs and 
scan-to-file jobs. The 
scanner locks when the  
scanner panel timeout 
expires.

System setting Reference on Path in Settings Editor
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Océ Account Console

Introduction to Océ Account Console

Océ Account Console is installed on a PC that functions as a server. Access to 
Océ Account Console is password protected and limited to the administrator. 
Use Océ Account Console for the following:

■ Manage, preview, and  publish the account information dialog for Océ 
Account Logic

■ Retrieve and export the log files.

Summary of Océ Account Console

Océ Account Console has the following three sections.

■ The ‘Account fields’ tab
Use this tab to create, manage, preview, and publish the ‘Account 
information’ dialog for Océ Account Logic.

■ The ‘Account data’ tab</ptxt>
Use this tab to define the devices from where the log files are retrieved.
Use this tab to export the log files.

■ The ‘Administration’ window.
Use this screen to define the administrative settings for the application, and 
to change the password for Océ Account Console.

Note: Please consult the Océ Account Center user manual and the on-line help 
in the application for detailed information.
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Chapter 11
The folder

This chapter describes:
■ The folder
■ The reinforcement unit
■ The belt unit
■ The punch unit
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Introduction

If you have a folder installed on your Océ TDS800 system, the following other 
optional features are available:
■ Reinforcement unit
■ First belt unit
■ Second belt unit
■ Punch unit
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Folder

The Océ TDS800 can have a folder to fold your output. The output is folded 
according to the selected folding width and length with the drawing method. 
Set the drawing method in the Océ Settings Editor (see ‘Find system settings 
in the Settings Editor’ on page 139). 

Note: You can only fold paper. Polyester, transparent or vellum media cannot 
be folded. If you try to fold polyester, transparent or vellum media, a media jam 
will occur.

Standard folding settings  By default, you use the standard folding settings 
defined for your Océ TDS800 system by the key operator. The following 
settings are available:

▼ Set the folded copy delivery

1 Press the ‘Finishing’ card in the ‘Print’ section.
2 Press the function key ‘Folded copy delivery’.
3 Select ‘Stacker’ or ‘Belt’.

▼ Set folding legend

1 Press the ‘Feeding’ card in the ‘Original’ section.
2 Press the function key ‘Legend location’.
3 Select ‘Leading’ or ‘Trailing’.

Note: In the drivers this setting is called the ‘Folding orientation’, with the 
options ‘Portrait’, ‘Landscape’ and ‘Automatic’.

▼ Set the drawing method

1 Press the ‘Feeding’ card in the ‘Original’ section.
2 Press the function key ‘Drawing method’.
3 Select ‘Standard’, ‘Ericsson’ or ‘Afnor’.

▼ Set the folded package width

1 Press the ‘Finishing’ card in the ‘Print’ section.
2 Press the function key ‘Folded package’.
3 Select ‘Width’. 
4 Enter a range between 186 - 230 mm or 7.3 - 9 inch, in steps of 1 mm or 0.1 

inch; default 210 mm or 9 inch.
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▼ Set the folded package length)

1 Press the ‘Finishing’ card in the ‘Print’ section.
2 Press the function key ‘Folded package’.
3 Select ‘Length’. 
4 Enter a range between 276 - 310 mm or 10.9 - 12.2 inch., in steps of 1 mm or 

0.1 inch; default 297 mm or 12 inch

▼ Set the binding strip

1 Press the ‘Finishing’ card in the ‘Print’ section.
2 Press the function key ‘Binding’.
3 Select binding enabled or disabled.
4 If you selected enabled enter a range between 15 - 30 mm or 0.6 - 1.2 inch, in 

steps of 1 mm or 0.1 inch; default 20 mm or 0.8 inch.

▼ Set the reinforcement

1 Press the ‘Finishing’ card in the ‘Print’ section.
2 Press the function key ‘Binding’.
3 Select ‘Reinforce’ enabled or disabled.

Note: Reinforcement is only possible with the Standard folding method

You can overrule the standard folding program with settings from the printer 
driver or the scanner operator panel. 

Find more information about Océ printer drivers in the on-line help. How to 
make folding settings on the Océ TDS800 Scanner panel is described below.

See ‘Standard folding settings’ on page 179 for complete information about 
defining default folding settings.

▼ Fold settings from the Océ TDS800 scanner operator panel

1 Open the ‘Feeding’ card in the ‘Original’ section and press the ‘Legend 
location’ function key to select the required legend location (‘Leading’ or 
‘Trailing’).
Note: Make certain that your legend is always located on your left-hand 
side to ensure correct positioning of the legend during folding.

2 Press the ‘Drawing method’ function key to select ‘Standard’, ‘Ericsson’ or 
‘Afnor’ fold.
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[84] Fold options from the scanner operator panel

3 Open the ‘Finishing’ card in the ‘Print’ section.
4 Press the ‘Folding’ function key to select ‘Full’ or ‘First fold only’ (see 

Figure 85).
5 Press the ‘Folded package’ function key and change the length and/or width of 

the folded package, as required, by using the arrow keys or the numeric keys.
6 If required, press the ‘Binding’ function key.

Set the required binding strip using the arrow keys or the numeric keys.
7 Make other settings as required.
8 Feed the original.

[85] Fold options from the scanner operator panel

You can also select a drawing method and, if needed, a folding length, folding 
width and binding strip. When you change the folding length and/or folding 
width, and the folder has a belt, you must also adjust the side guides of this 
unit.
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Maximum folding length  There are maximum values for different kind of 
paper. The tables below show the maximum values for three different weights 
of paper and the possible folded output for 110 grams paper.

Maximum output lengths for folding 
First fold output Stacker 2nd fold Stacker 2nd fold Belt 2nd fold

Paper weight 
[g/m2]

1st fold
[mm / inch]

2 folds
[mm / inch]

3 folds
[mm / inch]

2folds
[mm / inch]

60 1220 / 48 1220 / 48 1220 / 48 1220 / 48

75 6000 / 236 2500 / 98 2000 / 79 1220 / 48

110 2500 / 98 1220 / 48 not possible 1220 / 48

Folding settings 110 grams
Output length Delivery

‘Stacker’ or ‘Belt’
selected

 < 1220 mm
(3 folds)

Delivered in first fold delivery

 < 1220 mm
(2 folds)

Delivered on stacker or belt

 > 1220 mm 
< 2500 mm

Delivered in first fold delivery

> 2500 mm Unfolded, delivered in copy delivery 
tray

‘First fold only’ selected < 2500 mm Delivered in first fold delivery

> 2500 mm Unfolded, delivered in copy delivery 
tray
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Reinforcement unit

If you install a reinforcement unit, output can be delivered with a pre-punched, 
self-adhesive strip (see Figure 86). 

[86] Example a of reinforcement strip

With this strip the output can be stored in a binder, without running the risk that 
the punching holes tear out. You can unfold a folded map in a binder without 
opening the binder mechanism (see Figure 87). 

[87] Example of a folded map with a reinforcement strip

Protection sheet
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The optional reinforcement unit supports all media sizes larger than A4. 
However, A4 size media can also be reinforced if you enable A4 reinforcement 
in the Settings Editor (see ‘Find system settings in the Settings Editor’ on 
page 139). 

Note: Reinforcement is only possible with the Standard folding method.

See ‘Reinforcement unit’ on page 183 for more information about inserting a 
new tape roll and other maintenance issues.

▼ Enable reinforcement

1 Click on the ‘Jobs’ key in the Océ Settings Editor.
2 Select the ‘Copy’ tab if you want to enable folding reinforcement for copy jobs 

or select the ‘Print’ tab if you want to enable folding reinforcement for print 
jobs.

3 Open the ‘Defaults’ folder.
4 Open the ‘Finishing’ folder.
5 Select the ‘Folding reinforcement’ option.
6 Enable folding reinforcement in the right part of the window. 
7 Click on the ‘Apply’ key to save any changes you have made.
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Belt unit

The belt units offer a large capacity and more flexibility. On the belt unit 170 
folded A0 prints can be delivered offset stacked. You can adjust the side guides 
of the belt, depending on the width of the folded package.

Note: The belt unit can also be selected from the drivers or the scanner 
operator panel. The remote command overrules the key operator setting.

▼ Selecting belt as folded copy delivery on scanner operator panel

1 Open the ‘Finishing’ card in the ‘Print’ section of the scanner operator panel.
2 Press the ‘Folding’ function key to select full folding.
3 Press the ‘Folded copy delivery’ function key to select the belt.

You have 3 options (depending on your configuration): the upper belt, the 
lower belt of both belts.

▼ Adjusting the side guides of the belt

1 Loosen the nuts (see Figure 88).

[88] Adjust the side guides of the belt

2 Adjust the plate in accordance with the width of the fold package.
3 Tighten the nuts.

Note: If you change the folding width or the folding length, you have to adjust 
the punch unit.



186 Océ TDS800 User Manual

▼ Adjust the punch unit

1 Open the front door of the high capacity output unit of the folder.
2 Turn the black knob to adjust the folding width (see Figure 89). Refer to the 

sticker inside the unit.

[89] Knob to adjust the folding width in the punch unit

3 Loosen the screw and place the plate according to the folding length (see 
Figure 90).

[90] Nut to adjust the folding length in the punch unit

4 Tighten the screw. 

Belt full detection

The Océ TDS800 has a belt full detection on both belts. The attention light on 
the printer operator panel will go on if the belt is full. The system can switch 
belts when the first belt is full. You can set after how many jobs the belt is full. 
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Chapter 12
Media and supplies

This chapter describes how to:
■ Load paper
■ Add toner
■ Change tape in the reinforcement unit
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Load rolls of media

The Océ TDS800 has three paper roll compartments with each two rolls. The 
rolls one, three and five have a roll loader. Each of the rolls can be loaded with 
media of a different size or type. The operator panel displays the width and the 
type of media on each roll.

If you load new media, you must indicate to the system which type of media 
you have loaded: paper, transparent, vellum or polyester. The roll width is 
detected automatically.

The definition of the new media is important when ‘Automatic roll switch’ is 
on.

▼ Load paper

1 Open the correct paper roll compartment (see Figure 91).

[91] Open the correct paper roll compartment

2 If necessary clear the chip tray (see ‘Clear the chip tray’ on page 193)).
3 Remove the roll holder from the paper roll compartment.
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4 Press the green knob inside the roll holder to release the locking mechanism 
and remove the core from the holder (see Figure 92). 

[92] Remove the core from the holder

Note: You can place the new roll in the groove on the manual feed of the 
printer. See the arrow on picture 91 on page 188.

5 Press the locking mechanism down and slide the roll holder from the left into 
the core of the new roll.

6 Position the roll between the correct format indicators and release the locking 
mechanism (see Figure 93).

[93] Place a new roll on the holder



190 Océ TDS800 User Manual

7 Use both hands to put the holder in the paper roll compartment. First, position 
the left hand side of the holder in its notch, then position the right hand side in 
its notch (see Figure 94).

[94] Put the roll into the paper roll compartment

8 If the new roll does not have a straight leading strip you can cut it manually.
9 Press the correct button inside the paper roll compartment and feed the paper 

between the input guide plates as indicated by the arrow (see Figure 95). The 
material is fed into the machine. 
Note: Also see the stickers inside the roll compartments on how to feed 
paper.

[95] Button to feed the paper

10 Close the paper roll compartment. The material is cut. The size of material is 
indicated on the operator panel.
Note: If you have loaded another media type, you have to define the type 
(see ‘Define the media type’ on page 192).
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▼ Use the roll loader to load a roll

1 Fully open the roll compartment.
In the drawer, the roll loaders are installed. The roll loaders consist of a metal 
frame with a lever and a green knob in the middle of the lever.

2 Pull the horizontal lever to the right to put the roll loader in vertical position.
3 Pull the lever completely forward. The roll holder is lifted (see Figure 96).

[96] Roll loader in vertical position

4 Remove the roll holder from the paper roll compartment using both hands.
5 Press the green knob inside the roll holder to release the locking mechanism 

and remove the core from the holder.
Note: You can place the new roll in the groove on top of the manual feed of 
the printer. See the arrow on picture 91 on page 188.

6 Slide the roll holder in the new roll of material while you press the green knob.
7 Align the roll with the correct size indicator on the roll holder and release the 

locking mechanism.
8 Use both hands to place the holder in the roll loader (see Figure 94).
9 Put the holder back in the roll compartment by returning the roll loader lever 

to its vertical position.
10 Press the correct button inside the paper roll compartment and feed the paper 

between the input guide plates as indicated by the arrow (see Figure 95). The 
material is fed into the machine. 
Note: Also see the stickers inside the roll compartments on how to feed 
paper.

Attention: Be careful when you lift the lever to avoid damage to the roll 
compartment.

11 Use both hands to slide the material under the metal paper guide until it makes 
contact, follow the procedure ‘Load paper’ on page 188.

1

2
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▼ Define the media type

1 Press the ‘On-line’ key on the printer operator panel to put the printer Off-line. 
The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the media selection.
3 Use the arrow keys to select roll 1, to 6 (see Figure 97).
4 Press the right selection key to select the setting you want to define.
5 Use the arrow keys to define the settings.

Note: The system detects the media size. Media sizes of both the DIN and 
ANSI paper series are available. Use the Arrow buttons to select either a 
DIN or ANSI format.

6 Put the printer On-line again by pressing the ‘On-line’ key.

[97] To set the correct media

7 When you are ready, you can continue your job.

Ready to print

Selection keys
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Clear the chip tray

If the chip tray is full, you must clear the paper chips.

▼ How to clear the chip tray

1 Open the upper paper roll compartment.
2 Take out the chips (see Figure 98).

[98] The chip tray

3 Close the paper roll compartment.
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Add the toner

If the toner is empty the display shows: ‘Out of toner’ (see Figure 99). You can 
add toner even while you print a job. You can finish your current job. 

Note: If you do not add toner in time, the system will stop.

[99] ‘Out of toner’ message

▼ How to add toner

1 Shake the toner bottle.
2 Loosen the cap.
3 Open the front top cover.

Note: Only use E1 toner.
4 Open the toner refill opening.

Note: Do not remove the seal of the bottle opening.
5 Put the bottle with the ridge into the notch of the fill opening and push it down 

(see Figure 100).

[100] Put the toner bottle into the fill opening

The seal at the bottle opening is cut at the opening of the toner reservoir, 
allowing the toner to get out of the wide bottle.
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6 Hit the bottom of the bottle.
Note: Just add one bottle at a time.

7 When the bottle is empty, remove the bottle.
8 Close the fill opening
9 Lift top cover and pull the hinge towards you to close the top cover (see 

Figure 101).

[101] Close the top cover

10 Fasten the cap on the empty toner bottle. The Océ service engineer takes the 
empty toner bottles with him at the next visit.

Attention: If you have spilled some toner, (see ‘Safety data sheet Océ E1 
toner’ on page 263) for information about disposal and cleaning.
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Change the tape roll in the reinforcement 
unit

When the tape roll of the reinforcement unit is empty while the printer is in 
sleep mode, one of these messages appear on the display:

■ ‘Reinforcing not possible: out of tape’ for copy jobs.
■ ‘Load reinforcement tape’ for print jobs.
■ ‘No tape in reinforcement unit’ for copy and print jobs while the printer was 

running when the roll ran out of tape.

When a tape roll is empty while the printer runs, this message has a picture of 
the printer and the side door of the Reinforcement Unit flashes (see 
Figure 102).

[102] No tape in reinforcement unit
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▼ How to remove an empty tape roll

1 Open the side door of the reinforcement unit (see Figure 103).

[103] Open the side door off the reinforcement unit

2 Turn the two guide plates away from the pin roller into their fixed opened 
position (see Figure 104).

[104] Open the guide plate
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3 Remove the trailing strip of the old tape (see Figure 105).

[105] Remove the trailing strip of the old tape.

4 Remove the screw of the front side plate of the roll holder with the green nut 
and remove the old kernel.

Note: Clean the reinforcement knives before you put in a new roll

▼ How to insert a new tape roll

1 Put the new roll and close the side plate. Put the roll with the holes to the back 
and the protection sheet to the front (see Figure 106).

[106] Put the new roll
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2 Release the end of the roll and lead the tape over the large guide roller (see 
Figure 107).

[107] Guide the tape around the guide roller

3 Lead the tape between the upper and lower knife and over the pin roller (see 
Figure 108).

[108] Lead the tape between upper and lower knife
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Note: Make sure at least 200mm (2 strip lengths) of tape is past the knife 
section (see Figure 109)

[109] tape past the knife section

4 Align the holes in the tape to the hole pattern on the label on the frame plate of 
the reinforcement unit (see Figure 110). If the alignment is not correct, lift the 
tape from the pin roller and push the tape between the two knives until the 
holes are aligned.

[110] Adjust the holes on the tape
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5 Close the guide plates of the pin roller (see Figure 111)

[111] Close the guide plates

▼ How to prepare the tape roll for operation

1 Peel the protection sheet off the tape (see Figure 112).

[112] Peel off the protection sheet
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2 Lead the protection sheet back between the upper and lower knife (see 
Figure 113).

[113] Lead the protection sheet between upper and lower knife

3 Lift the guide and lead the protection sheet between the protection sheet 
rollers, pulling the protection sheet tight (see Figure 114).

[114] Lead the protection sheet between the rollers
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4 Insert the leading strip of the tape into the closed section of the slide (see 
Figure 115).

[115] Insert the tape into the closed section of the slide

5 Hold the upper guide plate down and cut the tape at the knife section and pull 
the strip up so that the tape is cut by the upper knife. (see Figure 116).

[116] Cut the tape at the knife section

6 Close the side door of the reinforcement unit.
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Chapter 13
Maintenance

This chapter describes:
■ The maintenance of the reference roller
■ The maintenance of the reinforcement unit
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Clean the reference roller

If the reference roller is dirty or static, you must clean the reference roller.

Attention: When you clean the reference roller, be careful not to damage the 
sensors on the scanner.

▼ How to clean the reference roller

1 Turn off the scanner.
2 Press the grip at the right hand side, below the original feed table, to open the 

top cover of the scanner (see Figure 117). 
Note: Make sure that you hold the top cover of the scanner.

[117] Open the top cover of the scanner
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3 Clean the white reference roller over it’s entire circumference with a soft cloth 
with a small quantity of Cleaner A.
For safety information see ‘Safety data sheets’ on page 260.

4 Press at the left and right side of the scanner to close the top cover of the 
scanner (see Figure 118).

[118] Close the top cover of the scanner

5 Turn on the scanner.
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Maintenance of the Reinforcement Unit

The maintenance for the Reinforcement Unit contains:
■ Clear the waste box
■ Clean the reinforcement knives

Attention: Only use the original Reinforcement Strips from Océ, to prevent 
the damage to the Reinforcement Unit.

Clear the waste box

If a reinforcement unit is installed, the protective sheet from the reinforcement 
tape is stored in a waste box.

Note: You can clear the waste box while you print.

▼ How to clear the waste box

1 Pull the waste box to the left hand side and towards you to open the waste box 
(see Figure 119).

[119] Open the waste box

2 Clear the box.
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3 Push the waste box forward and push it to the right hand side to close the waste 
box (see Figure 120).

[120] Close the waste box

Clean the reinforcement knives

The knives of the reinforcement unit get sticky from the glue on the 
reinforcement tape. Clean the knives when you insert a new tape roll (see 
‘Change the tape roll in the reinforcement unit’ on page 196) or when an error 
in the Reinforcement Unit occurred.

Put the knives into a position so that you have access to all parts. 

Attention: To avoid damage to the Reinforcement Unit, only use the original 
Cleaner K and Fixing Unit Cleaning Oil (silicon oil) from Océ.

▼ How to clean the reinforcement knives

1 Press the on-line key on the printer operator panel to put the printer off-line. 
The message ‘Off line’ is displayed in the status window.

2 Press the left selection key to shift the focus to ‘Clean reinf. knife’. A shadow 
effect is used to indicate that the focus is set to this menu.

3 Select the right selection key ‘Clean’. The reinforcement knives are placed in 
the correct position.

4 The machine stops and the yellow indicator on the printer goes ON. 
5 A picture of the printer appears on the display with the side door of the 

reinforcement unit flashes.
6 To see the text, press the ‘text’ key.

Note: When a job is running, the message ‘Job interrupted’ appears. The 
machine stops running after it has correctly finished the prints that were 
already in the printer.

7 Open the side door of the reinforcement unit (E).
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8 Clean the upper and lower knife with Cleaner K (see Figure 121).

[121] Clean the upper and lower knife

9 Oil the felt with Fixing Unit Cleaning Oil (silicon oil).

[122] Oil the felt

10 Close the side door of the reinforcement unit. 
The knives are placed back in its home position. The picture on the display 
disappears. The message ‘Press start to resume job’ or ‘Ready to print’ appears 
depending if a job was interrupted to clean the knives. 

11 The yellow indicator goes OFF.
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▼ Empty the waste basket

1 Open the front door of the folder (see Figure 123).
2 Lift the waste tray to remove the tray (see Figure 124).
3 Empty the waste basket.
4 Put the waste basket back in it’s original position. Make sure you feel the 

magnetic click.

[123] Open the front door of the folder

[124] Remove the waste tray

1 Remove the waste tray
2 Put it back. Use the magnetic force to put it back.
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Chapter 14
Problem solving

This chapter describes how to solve problems which can 
occur when you use the Océ TDS800.
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Introduction

Problems that can occur include
■ Original jams.
■ Paper jams,
■ Problems with the Reinforcement Unit,
■ Problems which you can correct if you follow the instructions on the display,
■ Other problems.

When an error occurs, the display informs you about:
■ What is the problem,
■ Where the problem occurred,
■ How to correct the problem.

Normally the paper moves through the system without problems. On the 
graphic display a cover or door indicates in which part of the system the paper 
has stopped. 

Stickers on some parts of the system indicate which green handles, green 
knobs, green bars and covers, etc. you have to lift, press or open to remove any 
jammed paper.

The display guides you through a sequence of steps to correct the problem. If 
a jam occurs in more than one location, the display will continue to instruct you 
until all jammed paper has been removed.

After you corrected the error, the display gives you instructions on how to 
continue the job.
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How to clear original jams

When you scan and an original jams, the message ‘Original jam’ appears on 
the scanner display. You must remove the original from the scanner.

▼ Remove a jammed original

1 Press the handle under the original feed table to open the top cover of the 
scanner (see Figure 125).

[125] Open the top cover of the scanner

2 Remove the original.
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3 Press the left-hand and right-hand side of the scanner down to close the top 
cover of the scanner (see Figure 126).

[126] Close the top cover of the scanner

4 Make the original smooth and feed the original.

If an original jam occurs often:
■ Check if you use the correct type of original. 
■ Check if you insert the original along the guide.
■ Check if the original is damaged before you insert it.
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How to clear paper jams

When paper jams, the printing stops and the message ‘paper jam’ appears in 
the display. The error location is shown by flashing covers or doors.

When paper jams:
■ Follow the instructions on the display
■ Leave the main power turn on to prevent the data loss, and correct the paper 

jam as described in the equivalent chapter.
■ Remove all the pieces of paper from the machine.

If a paper jam occurs often, check if:
■ The paper is refilled correctly, (see ‘Load rolls of media’ on page 188).
■ The correct paper is used, (see ‘Overview of the Océ TDS800 system’ on 

page 242).
■ All the pieces of paper are removed from the paper path.

Paper jams can occur in:
■ The manual feed
■ The fuser section
■ The roll feed section
■ The folder
■ The reinforcement unit
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[127] Paper jam section

Paper jam in the manual feed

▼ How to clear a paper jam in the manual feed

1 Pull the manual feed table toward you to open (see Figure 128).
Note: Make sure that you open the manual feed table complete.

[128] Open the manual feed table

B: roll feed section (see page 223)

C: fusing section (see page 219)

A: manual feed
(see page 218)

D: folding section
(see page 227)
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2 Lift the green lever to open the plate.

[129] Remove the paper

3 Remove all the paper.
4 Lower the plate.
5 Push the manual feed table back in the original position.

Paper jam in the fuser section

▼ How to clear a paper jam in the fuser section

Caution: When you remove the paper in the fuser section, always wear the 
heat-resistant gloves. The heat-resistant gloves are in the left hand cover of 
the paper output unit.

1 Remove the output delivery tray (see Figure 130).

[130] The output delivery tray
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2 Open the top cover at the rear side (see Figure 131).

[131] The top cover at the rear side

3 Pull the green lever toward you to open the output transport unit (see 
Figure 132).
Note: If you can not open the transport unit, you have to cut the paper and 
remove the paper.

[132] The lower cover
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4 Pull the green bar of the fuser section toward you to open the fuser section.(see 
Figure 133)

[133] The bar of the fuser section

5 Take the crank found on the right hand cover of the paper output unit.
6 Insert the crank in the slot and turn to the right. The paper is delivered from the 

paper output unit.

[134] The crank

7 If the paper keeps coming, it is not cut and you have to cut it manually. 
8 Cut the paper and turn the crank to the right to deliver the paper.
9 Remove the crank and return it to its original position.

10 Pull the handle 1 towards you to open the pre-heater section (see Figure 135 on 
page 222).

11 Pull the green handle 2 toward you and release handle 1 (see Figure 135 on 
page 222).
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12 Pull the green bar 3 toward you (see Figure 135).

[135] The pre-heater section

Close as follows:
13 Push the bar 3 back.
14 Press the handle 1 downwards.
15 Press the handle 2 back.
16 Close the bar of the fuser section.
17 Close the lower cover of the output unit.

Caution: Do not hold your hand between the green lever and the lower 
cover when you close the cover. The lever moves toward the cover and can 
cause personal injury.

18 Unlock the green bar and close the top cover. 

1
2

3

1

2

3
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If you can not correct the problem, you can open the output transport unit and 
remove the paper (see Figure 136 on page 223). If the fuser-section covers 
remain to flash on the display, check the fuser section again.

[136] Open the transport output unit

Paper jam in the paper roll compartments

▼ How to clear a paper jam in the paper roll compartments

Note: Make sure that you corrected all the problems in the fuser section, 
before you correct the problem in the roll feed section.

1 Completely open the correct paper roll compartment. 
2 Remove any jammed paper:

■ Behind the chip tray
■ Underneath the plate
■ Underneath the roll 2, the roll 4 or the roll 6 feed plate

3 Reload the roll if necessary.
4 Close the paper roll compartment.
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Paper jam behind the chip tray

▼ How to remove the paper behind the chip tray

1 Turn the green knob of the chip tray (upper compartment) or the vertical 
transport unit (lower compartment) (see Figure 137).

[137] Knob of the chip tray or vertical transport unit

2 Remove all the pieces of material.
or,

3 Lift the chip tray and pull the tray toward you to open the tray (see Figure 138).

[138] Open the chip tray

4 Remove all the pieces of material.
5 Push the chip tray in its original position.
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Paper jam in the vertical transport unit

▼ How to remove the paper in vertical transport unit

1 Open the vertical transport in the lower and middle paper roll compartment 
(see Figure 139).

[139] The vertical transport in the lower and middle compartment

2 Turn the green knob to remove all the pieces of material in the vertical 
transport unit.

3 Close the vertical transport.
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Paper jam underneath the roll 1, roll 3 and roll 5 triangular feed 
unit

▼ How to remove paper underneath the roll 1, roll 3 and roll 5 triangular feed 
unit

1 Remove roll 1 (upper compartment) or roll 3 (middle compartment) or roll 5 
in the lower compartment.

2 Pull the feed unit underneath the roll holder toward you to remove the unit (see 
Figure 140).

[140] The triangular feed unit

3 Remove all the pieces of material.
4 Return the triangular feed unit correctly. 
5 Close the paper compartment.

Note: If the covers continue to flash on the operator panel, check the roll feed 
section again.
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Paper jam in the first fold section of the folder

▼ How to clear a paper jam in the first fold section of the folder

1 Open the cover of the first fold section (see Figure 141).

[141] The cover of the first fold section

2 Pull the green lever of the guide plate (A) to the first fold section to open the 
first fold section (see Figure 142).

[142] The guide plate A of the first fold section

A
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3 Remove all the pieces of material.
4 Open the next guide plate (B) (see Figure 143).

[143] Open guide plate B

5 Remove all the pieces of material.
6 Close the guide plate B.
7 Lock the guide plate A to the first fold section with the green lever.
8 Close the cover of the first fold section.

▼ How to clear a paper jam in the folder transport section

1 Open the cover of the transport section to the first fold delivery at the left side 
(see Figure 144).

[144] The cover of the transport section to the first fold delivery

2 Remove all the pieces of material.
3 Close the cover of the transport section.

B
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▼ How to clear a paper jam in the second fold section

1 Open the front door of the second fold section (see Figure 145).

[145] The front door of the second fold section

2 Remove all the pieces of material at the bottom of the second fold section.
3 Close the front door of the second fold section.
4 Open the delivery unit (see Figure 146).

[146] Open the delivery unit
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5 Open the guide plate with the green lever (see Figure 147).

[147] The guide plate with the green lever

6 Remove all the pieces of material.
7 Open the vertical transport with the green lever (see Figure 148).

[148] The vertical transport

8 Remove all pieces of material.
9 Close he vertical transport.

10 Close the guide plate.
11 Close the delivery unit.
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Clear a paper jam in the high capacity output unit of the folder

▼ How to clear a jam in the high capacity output unit of the folder

1 Open the top and lower door of the output unit.
2 Press the two knobs and open the plate (see Figure 149).

[149] Open the plate

3 Remove all pieces of material.
4 Fasten the plate.
5 Close the top and lower door.
6 Open the lower door. 
7 Press the two knobs of the upper plate and lower the plate (see Figure 150).

[150] Lower the plate
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8 Remove all pieces of material.
If it is not possible to remove the jammed media:

9 Loosen the nuts and remove the plate

[151] Loosen the nuts and remove the plate

10 Remove all pieces of material.
11 Replace the plate and tighten the nuts.
12 Close the lower door.
13 Open the front door.
14 Lift the waste tray to remove the tray (see Figure 152).

[152] Remove the waste tray
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15 Lift the next plate (see Figure 153).

[153] Lift the plate

16 Remove all pieces of material.
17 Open the cover behind the delivery tray for the second fold (see Figure 154).

[154] Open the cover behind the delivery tray for the 2nd fold

18 Remove all pieces of material.
19 Close the cover, lower the plate and position the waste tray.
20 Close the front door.
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Problems with the Reinforcement Unit

If a Reinforcement Unit is installed, the following errors can occur:
■ Paper jams
■ Tape jams
■ No reinforcement strips on the output

This section explains how you can correct these errors.

Clear paper jams in the Reinforcement Unit

When a paper error occurs, the following message appears: ‘Paper jam’. A 
picture of the printer appears on the display with three doors that flash (see 
Figure 155).

[155] Example of a paper jam
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▼ How to clear a paper jam

1 Open the cover of the transport to the First Fold delivery and remove all paper 
inside the first fold delivery (see Figure 156).

[156] The cover of the folder transport section

2 Close the cover of the folder transport section.
3 Open the front door of the Reinforcement Unit (see Figure 157).

[157] The front door of the Reinforcement Unit
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4 Open the top cover of the Reinforcement Unit and remove all pieces of 
material inside the unit (see Figure 158).

[158] The top cover of the reinforcement unit

5 Close the top cover and the front door of the Reinforcement Unit.

Clear tape jams in the Reinforcement Unit

When a tape jam occurs one of the following messages appears on the display:
■ ‘Reinforcing not possible: tape jam’ for copy jobs
■ ‘Re-feed reinforcement tape’ for print jobs.
■ ‘Tape jammed in reinforcement unit’ for print and copy jobs while the printer 

was running.

When a tape jam occurs while the printer runs, the message has a picture of the 
printer. The picture shows that the side door of the Reinforcement Unit flashes 
(see Figure 159).

sa

[159] Tape jam in reinforcement unit
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▼ How to clear a tape jam

1 Open the front door of the Reinforcement Unit (see Figure 160).

[160] Open the front door of the reinforcement unit

2 Turn the two guide plates away from the pin roller into their locked opened 
position (see Figure 161).

[161] The two guide plates
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3 Remove all tape between the rollers and knives (see Figure 162).

[162] Remove the tape

4 Insert a new trailing strip of tape between the rollers and the knives. For 
complete information refer to ‘Change the tape roll in the reinforcement unit’ 
on page 196.

No reinforcement strips on the output without an error message

This error occurs when there are no reinforcement strips on the output although 
reinforcement is selected. This can happen when the file header (Remote 
Control Format or Océ Job Ticket) contains instructions to have no 
reinforcement.

Note: If you want to process A4 formats, reinforcement can be disabled for this 
format.

▼ To solve this error

1 Press the Stop key on the operator panel twice.
2 Open the side door of the Reinforcement unit.
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3 Check if there are loose reinforcement strips in the unit with the protection 
sheet still on(see Figure 163).

[163] Situation A: No mechanical error Situation B: Mechanical error

4 If yes, remove the tape strips in the Reinforcement Unit.
If the protection sheet is not on the reinforcement strip (see situation A in 
figure 204), there is no mechanical error and you should insert a new tape roll 
as described in ‘Inserting a new tape roll’ on page 143. If this error frequently 
occurs you should call the Océ service organisation (see ‘Other problems (call 
service)’ on page 184).

5 Remove all tape between the rollers and knives (see Figure 164)

[164] Remove the tape

6 Wire a new trailing strip of tape between the rollers and the knives ‘Change the 
tape roll in the reinforcement unit’ on page 196.
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Other problems 

If you have a problem that you can not correct, call the Océ service 
organisation. In this case turn off the system with the main switch and leave the 
system as it is.
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Overview and tables
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Overview of the Océ TDS800 system

[165] The Océ TDS800 system

1 The monitor
2 The scanner
3 The scanner operator panel
4 The printer operator panel
5 The printer
6 The folder and stacker unit
7 The output delivery tray
8 The first fold unit
9 The original delivery tray

10 The controller cabinet

1 2 3
4

5 6

7

8

9
10
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Printer operator panel

Ready to print

On-line 
key

Stop key

Selection
keys

Arrow
keys

The display
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Scanner operator panel

1 The Exposure control
2 The display
3 The Section keys
4 The Arrow keys
5 The Media selection keys
6 The Manual feed key
7 The Auto roll key
8 The Correction key
9 The Stop key

10 The Job interrupt key
11 The numeric keys
12 The Function keys
13 The numeric display
14 The Start key

1 2
3

4 5

6789121314

10
9
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Product specifications Océ TDS800

The Océ TDS800 is a wide format, black and white, high volume 
multifunctional system. The Océ TDS800 offers a broad range of print, copy, 
and scan-to-file function.
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Printer
Technology Océ Copy Press with organic photoconductor and LED 

exposure

Resolution 400 dpi

Speed 13 meters p/min. or approx. 10 A0 /min.

Media sources 6 rolls (maximum capacity 200 m per roll).
Manual sheet feed from A4 to 36”.
Roll widths 297 mm - 914 mm

Output sizes DIN and ANSI formats from A4 to A0 and 36”, up to 200 
meters long.

Media types Plain, transparent, fluorescent and colored papers; films 
and vellums

Output reception Output Delivery Tray (ODT) for 150 prints

Warm-up time 17 minutes

Electrical requirements 50 Hz / 230 V 3φ: 16/12/11 A
50 Hz / 400V 3φ: 11/6/7 A
50 Hz / 415V 3φ: 11/6/6 A
50 Hz / 200V 3φ: 17/12/12 A

60 Hz / 240 V 21 A
60 Hz / 200 V 3φ: 18/13/12 A
60 Hz / 208 V 3φ: 17/12/12 A
60Hz / 220 V 3φ: 17/12/11 A
60 Hz / 240 V 3φ: 15/12/9 A
60 Hz / 380 V 3φN: 11/6/6 A
60 Hz / 415 V 3φN: 12/6/6 A

Dimensions Printer 1720 mm (W) x 1146 mm (H) x 1400 mm (D)

Weight 939 kg
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Safety approvals TüV GS, CETECOM, CE, UL, (c)UL, CB, FCC Class B

Function Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll selection and switching
Print manipulation: auto-positioning, rotation, 
auto-scaling
File spooling on the controller
Set memory: send once, process once, print many; capacity 
to store up to 250 A0s and create identical sets sorted by 
page or by set
Concurrent receiving, processing, printing, and finishing 
of digital jobs
Sophisticated local and remote user communication 
system with:
Océ Queue Manager application: view status for each job 
and cancel, hold and restart the entire job. Inbox and 
history functionality.
Océ System Control Panel application: view status and 
settings of system components
Océ Settings Editor application: customise system settings

Printer (continued)
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Océ Power Logic® Controller
Platform Océ Power Logic® Controller with embedded Windows 

XP®

Memory 512 MByte RAM standard

Disk space High-speed hard disk dedicated to file spooling. 
High-speed hard disk dedicated to set memory offering at 
least 250 A0 storage capacity.

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, NIRS, 
EDMICS (C4), CalComp 906/907/951, Adobe® 
PostScript® 3™

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45
Optional: Token Ring 4/16 Mbits/s.

Network protocols TCP/IP, Novell (IPX, SPX)

Account logging 
(optional)

Records print, copy, and scan-to-file jobs by user and 
account number. Information stored in a (ASCII or 
UTF-16) file for later re-use

Job templates (optional) Gives direct access to five different sets of settings on the 
scanner operator panel.

Océ Remote Logic® Applications
Model Local and remote user communication system

Applications Océ Settings Editor:
customise system settings
Océ Queue Manager:
view and edit status for each job, history queue, inbox 
queue.
Océ System Control Panel:
view status and settings of system components

Supported platforms Windows® 95/98/2000, NT4.0® and XP. Apple 
Macintosh® OS, Unix (including Linux, HP-UX 10.20 
and 11.00, and IBM AIX)

Scanner
Model Free-standing console

Optional: Original delivery tray

Technology CCD, Océ Image Logic® real-time image processing 
hardware

Speed 10 linear metres per minute or approximately 8A0s per 
minute

Original feed Face up, left aligned
Automatic feed off/on
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Originals Automatic original size detection
Width A4 to 36”
Length up to 15 m

Maximum thickness 1 mm

Exposure control Automatic, manual fine adjustment
Special modes: Lines & Text (default), Photo, Greys & 
lines, Dark Original, Blueprint, Cut & Paste

Media selection Manual or automatic, based on original size (autodetect) 
and zoom factor.
Auto format detection of ISO and ANSI standard sizes.

Reproduction scale Zoom: 25% - 400% (adjustable in 1% and 0.1% steps)
8 programmable fixed steps
Auto zoom to paper size

Input mode Single sheet
Set (sets processing/set collation)
Multiple sheets

Function Concurrent scanning and printing
Multi-copy mode: 1-999 copies (scan once print many)
Pre-programming of next job
Programmable default settings
Programmable custom card
Automatic roll selection
Automatic reduction/enlargement
Standard cut, synchro cut and custom cut modes
Leading and trailing strip adjustment (up to +/- 400 mm)
Two languages available

Image editing Image align: Horizontal left, middle, right
Image align: Vertical top, middle, bottom
Image shift: horizontal/vertical up to +400 mm
Image mirroring

Noise level 65 dB (A) operating, <45 dB (A) in stand-by

Electrical requirements 50 Hz / 100 V 2,5 A
50 Hz / 230 V 1 A

60 Hz / 100 V 2,5 A
60 Hz / 120 V 2 A
60 Hz / 230V 1 A

Dimensions 1320 mm (W) x 640 mm (D) x 1235 mm (H)

Weight 166 kg

Océ Scan Logic® (optional)
Applications Océ Scan Manager®, integrated scanning solution

Scanner (continued)
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platform Océ Power Logic® Controller with embedded Windows 
XP®

Scan destinations 10 programmable destinations
Scan to controller
Scan to network directory
File Transfer Protocol (FTP)

Resolution 200, 300, 400 dpi

Data formats Tiff (G3, G4, uncompressed, tiled, stripped, raw) with 
optimization to filesize or quality
CALS type 1
Optional: Adobe® PostScript® 3™/PDF (G4, 
uncompressed). 5 additional Japanese fonts for 
Adobe® PostScript® 3™ are available as an option.

Scan modes Single scan, stream feed productive batch scanning

File naming Automatically generate unique file names for each scan. 
Determine file name before scanning.

Check print Single / multiple check prints

Viewing View scans at point of scanning

Océ Image Logic® Optimum scan quality with six special original modes. 
“Right first time” productive scanning for larger volumes.

Ease of use Scan to file from scanner panel, scan directly to destination

Options Océ View Station: Edit and enhancement software
Océ Batch Processor: Automated editing software
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Océ Matrix Logic® (optional)
Applications Océ Matrix Logic®, integrated Matrix Copy solution

Platform Océ Power Logic® Controller with embedded Windows 
XP®

Function Allows you to form in one single operation different copy 
sets from one set of originals

Drivers and job submission software
Océ HDI driver For AutoCAD® 2000

Windows® 95/98/2000, NT 4.0® and XP

Océ Windows driver Windows® 95/98/2000, NT 4.0® and XP

PostScript Level 3 
drivers

For Windows® 95/98/2000, NT 4.0® and XP
Macintosh® OS 7.x/8.x

Océ Print Exec® LT Single seat job submission software for Windows® 
95/98/2000, NT 4.0®, XP and Millennium

Océ Print Exec® 
Workgroup

Multi-seat job submission and back channel 
communication software using standard web browsers: 
Internet Explorer® 4.02 SP2 or higher and Netscape® 4.08 
or higher

Océ Repro Desk A print management solution for the reprographer 
and their clients. 

Optional: Integrated Folder and reinforcement unit
Folding methods Standard (DIN), Ericsson, Afnor-like

Fan fold or fan fold & cross fold
Length: 276 - 310 mm
Width: 186 -230 mm
Binding strip: 15 -30 mm

Paper size Width: 279 -914 mm
Length: 210 -2,500 mm
210 - 2,500 mm for fan fold and cross fold at 75 grams, 
up to 6000 mm fan fold only at 75 grams

First fold exit Extra bin for fanfold

Noise level < 67 dB(A) operating; 0 dB(A) stand-by

Dimensions 2430 mm (W) x 1560 mm (D) x 1400 mm (H) (excluding 
reinforcement unit including printer)
2560 mm (W) x 1560 mm (H) x 1400 mm (D) (including 
reinforcement unit and printer)
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Weight 124 kg unpacked excluding reinforcement unit
154 unpacked including reinforcement unit

Optionals Reinforcement unit
Punch unit
2 Belt delivery trays for 340 A0

Optional: Original / Output delivery tray
Model Wheeled delivery tray with blower unit

Capacity Up to 200 prints or originals (media type dependent)

Electrical requirements 100-120 / 200-230V, 0.3A, 50/60Hz

Types of media Plain paper, transparent paper, film, vellum and polyester

Dimensions 1160 mm (W) x 1880-1340 mm (H) x 1020 mm (D)

Weight 44 kg

Optional: Delivery Belt Unit
Single belt unit Delivery belt with offset stacking

Belt capacity: approximately 170 folded A0s at 75 g/m2

Optionals Second delivery belt
Belt capacity: 170 folded A0s at 75 g/m2
Punching unit Europe (2 or 4 holes)
Punching unit USA (3 holes)

Mains supply From printer

Dimensions Required floor space: 1730 mm x 1700mm

Weight 125 kg (one belt unit without puncher)
40 kg (second belt)
10 kg (puncher)

Optional: Integrated Folder and reinforcement unit (continued)
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List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance. 
It is therefore recommended to use only approved Océ materials in the Océ 
TDS800.
A full list of Océ materials suited for use in the Océ TDS800, including plain 
paper, transparent paper, colored papers and various polyester films is 
available from your Océ representative.

Material types  The following material types are available for the Océ TDS800:

Overview of print material that can be used
Plain paper 60 to 110 g/m2

Transparent paper 80 to 110 g/m2

Vellum 16 - 20 lbs

Polyester film 3.5 or 4.5 mil

Top label ECF 60 g/m2

Special colored paper, etc.

Minimum Maximum

Width 210 mm 914 mm

Length 279 mm 15 m
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Material sizes  The following material sizes are available for the Océ TDS800:

Attention: Avoid storing paper in rooms where temperature and humidity 
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic 
to prevent it absorbing moisture.

Overview of material sizes that can be used
Format Width Length Format Width Length

ISO range ANSI range

A4 portrait via 
manual sheet 
feed

210 mm 297 mm A portrait 8.5” 11”

A3 297 mm 420 mm B 11” 17”

A2 420 mm 594 mm C 17” 22”

A1 594 mm 841 mm D 22” 34”

A0 841 mm 1,189 mm E 34” 44”

Format Width Length Format Width Length

ANSI PLUS 
range

Others

A+ portrait 9” 12” 30” 30” 42”

B+ 12” 18” B1 707 mm 1,000 mm

C+ 18” 24” B1+ 700 mm 1,000 mm

D+ 24” 36” B2 500 mm 707 mm

E+ 36” 48” B2+ 500 mm 700 mm

Overview of paper series
Paper series Formats included

ANSI Mixed 8.5” 
- 9”

11” 
- 
12”

17” 
- 
18”

22” 24” 30” 34” 36”

ANSI Small 8.5” 11” 17” 22” 24” 30” 34” 36”

DIN Carto A4 A3 A2 B2_700 A1 B1_700 A0 36”

DIN A4 A3 A2 B2_707 A1 B1_707 A0 36”
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Reinforcement strips

Information about the different reinforcement strips is available from your Océ 
representative.

Attention: Only use the original reinforcement strips from Océ to avoid 
damage to the reinforcement unit.
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Instructions for safe use

Océ designed products have been tested in accordance with the strictest 
international safety standards. To help assure safe working with these products 
it is important that you observe the following safety rules: 

Maintenance  

■ Do not remove any screws from fixed panels.
■ Do not carry out maintenance activities except for the parts and maintenance 

materials mentioned in this manual.
■ Do not place any liquids on the machine.
■ Use maintenance materials or other materials for their original purpose only. 

Keep maintenance materials away from children.
■ Do not mix cleaning fluids or other substances.
■ To avoid the risk of introducing hazards, all modifications to Océ equipment 

are strictly reserved to properly qualified and trained service technicians.

Connection  

■ Do not move the machine yourself, but contact your Customer Service. 
■ If for some reason you have to move the machine yourself, please make sure 

that the mains power point has the right fuse capacity. See the Océ TDS800 
safety data sheet in this appendix for information about maximum current.

■ Do not bridge any mechanical or electrical circuit breakers.
■ Do not use an extension lead to connect the machine.
■ It is recommended to connect only those copy-control products (or other 

products) which meet the national and international product safety and radio 
frequency interference standards, and to use an attachment cable as specified 
by Océ.

■ This equipment has not been designed for connection to an IT power system. 
(An IT power system is a voltage network in which the neutral wire is not 
connected to earth).

■ For equipment connected via a wall socket: locate the machine close to a wall 
socket that is easily accessible.

■ For equipment connected via a fixed connection to the electricity grid: the 
disconnect device in the fixed connection should be easily accessible.
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Surroundings  

■ Do not block the ventilation openings of the machine.
■ Ensure that the machine is placed on a level, horizontal surface of sufficient 

strength. See the Océ TDS800 safety data sheet in this appendix for 
information about the weight of the equipment.

■ Ensure there is sufficient space around the machine. This facilitates 
reloading materials as well as maintenance.

■ Do not place the machine in rooms which are subject to excessive vibration.
■ Do not place the machine in rooms which are too small or insufficiently 

ventilated. See the Océ TDS800 safety data sheet in this appendix for 
information about space and ventilation requirements.

General  

■ Always use materials recommended by Océ and developed for this Océ 
machine. Materials not approved by Océ may result in faults in your 
machine.

■ Do not use the machine when it is emitting unusual sounds. Remove the plug 
from the power socket or switch off the fixed connection to the electricity 
grid and contact Customer Service.

Note: This is a class A product. In a domestic environment this product may 
cause radio interference in which case the user may be required to take 
adequate measures
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Safety data sheets

The disclaimer below is valid for all safety data sheets in this manual. 
For questions about Océ products regarding health, safety and environment, 
please contact your Océ organisation; you can find the address in the last 
appendix of this manual.

Disclaimer  The safety data sheets in this manual have been compiled to the 
best of our knowledge as a compact guide to safe handling of this product. We 
reserve the right to revise safety data sheets as new information becomes 
available. It is the user’s responsibility to determine the suitability of this 
information for the adoption of safety precautions as may be necessary and to 
contact the company to make sure that the sheet is the latest one issued. If and 
in so far as limitation of liability is permitted under the applicable laws, we do 
not accept liability for any inaccuracy that may occur in this information.
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Safety data sheet Océ TDS800 printer

The content of this safety data sheet is subject to the disclaimer of liability on 
page 260 of this manual.

PRODUCT SAFETY DATA SHEET

Number E-730-a-UK
Date January 2001

Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Model Océ TDS800 printer engine

Description Electrophotographic printer, console model, plain paper, organic photoconductive drum, 
powder toner .

Max. process speed 13 m/min

Dimensions Width 1720 mm 
Depth 1146 mm
Height 1400 mm

Weight 939 kg

Voltage 230 V 400 V 415 V 
Frequency 50 Hz 50 Hz 50 Hz
Current-rated 16/12/11 A 11/6/7 A 11/6/6 A
Power consumption, low power 495 W
Power consumption, stand by 820 W
Power consumption, operation 4100 W
EPA ENERGY STAR ®
* Power consumption sleep mode 13 W (without controller)
Mains connection Cables with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at bystander position)

Standby In operation
46 dB(A) main body 59 dB(A)  

impulse  Li = 1 dB(A)
Sound power level 59 dB(A) main body 70 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 820 W; at continuous operation 4,1 kW
Ozone emission 0,02 mg/min at continuous operation

Room volume Recommendation: min. 75 m3

Room ventilation Recommendation: min. 37,5 m3/h (natural ventilation)
For heat evacuation extra ventilation may be necessary

Use simulation at random 
operation

Room volume and ventilation as recommended
Daily copy volume (much more than average) 1200 m2

Total worktime 8 h
Ozone concentrations:
- Time weighted average < 0,001 mg/m3 (<0,0005 ppm)
- Peak 0,0015 mg/m3 ( 0,0008 ppm)

Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m3 (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)

Consumables Océ 9800 OPC (Océ Safety Data Sheet E-194)
Océ E1 Toner (Océ Safety Data Sheet E-198)
Océ Copying Materials

Additional safety information The ozone filter does not have to be replaced to keep the ozone concentration in the 
workplace below 0,04 mg/m3 (i.e. the life of the filter equals that of the apparatus).

CE-Compliance Approved according to Approved according to EPA ENERGY STAR ®
Low Voltage Directive EMC Directive

73/23/EEC 89/336/EEC
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Safety data sheet Océ TDS800 scanner

The content of this safety data sheet is subject to the disclaimer of liability on 
page 260 of this manual.

PRODUCT SAFETY DATA SHEET

Number E-729-a-UK
Date January 2001

Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Model Océ TDS800 Scanner

Description Freestanding scanner, maximum original size 1036 mm x 6000 mm
Max. process speed 10 m/min

Dimensions Width 1320 mm
Depth 640 mm
Height 1235 mm

Weight 147 kg

Voltage 230 V
Frequency 50 Hz
Current-rated 1 A
Power consumption,stand by 165 W 
Power consumption, operation 180 W at continuous operation 
EPA ENERGY STAR ®
* Power consumption low power 7 W 
Mains connection Cable with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at operator position)

Stand byIn operation
43 dB(A)main body 53 dB(A) 
impulse  Li = 9 dB(A)

Sound power level 56 dB(A)main body 68 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby165 W; at continuous operation 180 W
Ozone emission Not applicable

Room volume No special requirements
Room ventilation

Consumables Not applicable

Additional safety information None 

CE-Compliance Approved according to Approved according to EPA ENERGY STAR ®
Low Voltage Directive EMC Directive

73/23/EEC 89/336/EEC
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Safety data sheet Océ E1 toner

continued on the next page

MATERIAL SAFETY DATA SHEET Number E-198-b-UK
(93/112/EEC and ISO 11014-1) Date July 1997

Page 1 of 2
Océ E1 Toner

1. Product and company identification

Product name Océ E1 Toner
Packing Polyethylene bottle, contents 1,0 kg /2.1 lb

Company Océ (UK) Ltd.
Address Langston Road, Loughton, Essex IG10 3SL
Telephone 0181-508 5544 (contact product safety coordinator)
Telefax 0181-508 6689

2. Composition / information on ingredients

3. Hazards identification

In a toner dust cloud the formation of an explosive dust-air mixture is possible.
Toner dust may cause discomfort for the eyes and respiratory tract, in the same manner as inert nuisance dust.
To our knowledge, with due observance of the recommended exposure limit and of normal hygiene this product presents no health hazard
in normal use.

4. First aid measures

Eyes contact Rinse with plenty of water.
Skin contact Wash with cold water and soap.
Inhalation Clean nose, mouth, throat. Cough up. Fresh air.
Ingestion Rinse mouth with water. If large quantity swallowed seek medical advice.

For any medical advice take along this material safety data sheet.

5. Fire fighting measures

Extinguishing media Dry chemical, carbon dioxide, water spray (fog), foam
Special fire fighting precautions N.A.
Hazardous products of decomposition N.A.

6. Accidental release measures

Spills can be cleaned with a vacuum cleaner or a damp rag. Do not use warm water, because this makes the powder soft and sticky.

7. Handling and storage

Keep bottle tightly closed to prevent dust formation. Handle carefully. Avoid breathing dust. Keep in a cool dry place (38 oC, 100 oF).
Keep away from direct sunlight or heating devices.
No special technical measures for storage.

8. Exposure controls / personal protection

No special technical measures. No personal protective equipment needed.
Industrial hygiene: after skin contact wash with cold water and soap.
Threshold Limit Value for nuisance dust: 10 mg/m3.
Threshold Limit Value for carbon black: 3,5 mg/m3.
Threshold Limit Value for amorphous silica: 10 mg/m3.

Ingredients CAS No. ClassiÞcation Weight %

Polyester resin 170831-75-1 25-50
Iron oxide 1317-61-9 25-50
Phenoxy resin PMN P-95-461 10-25
Carbon black 1333-86-4 1-5
Amorphous silica 68611-44-9 <1
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The content of this safety data sheet is subject to the disclaimer on page 260 of 
this manual.

MATERIAL SAFETY DATA SHEET Number E-198-b-UK
(93/112/EEC and ISO 11014-1) Date July 1997

Page 2 of 2
Océ E1 Toner

9. Physical and chemical properties

Explosion limits (dust explosion) LEL 60 g/m3. UEL U (= unknown) Flash point (oC) N.A. (=Not Applicable)
Appearance and odour Black powder, faint odour Ignition temperature (oC) U
Boiling point (oC) N.A Bulk density (kg/m3) ca 1000
Vapour density (air = 1) N.A. Softening point (oC) Approx. 50
Solubility in water Insoluble Evaporation rate (butyl acetate = 1) N.A.
Vapour pressure N.A. % Volatile 0
Other characteristics N.A. pH (solution) N.A.

10. Stability and reactivity

Thermal decomposition Above approx. 450 oC
Hazardous decomposition products None at intended use
Hazardous reaction None
Combustion products Carbon dioxide, carbon monoxide, water

11. Toxicological information

12. Ecological information

This product is not biodegradable.
The ingredients are not classified as ecologically hazardous. No adverse environmental effects are expected.

13. Disposal considerations

Pack waste dustproof to prevent dusting. With due observance of local laws and regulations, dispose of by burial in a sanitary landfill or
incineration. Do not throw in open fire, in order to prevent the risk of a dust explosion.

14. Transport information

This product is not classified as a dangerous substance according to the international transport regulations.

This product is not classified as a dangerous preparation according to the European Directives 67/548/EEC and 88/379/EEC for the
classification, packaging and labelling of dangerous substances and preparations.
Therefore, indications of special risks or safety advice on the packing are not prescribed for this product.

15. Regulatory information

16. Other information

Use: ink powder for printers.
Room ventilation: see operator manual or safety data sheet for the printer.
This MSDS replaces MSDS E-179 for Oc  9800 Toner.
Revision of E-198-a-UK dated March 1997.
Modifications: information on ingredients changed.

Copyright © 1997 Océ-Technologies B.V. Venlo, NL

Inhalation * At high concentration in air the powder may cause discomfort of upper respiratory system.
Skin * No adverse health effects are expected.
Eyes * Dust may cause discomfort in the same manner as nuisance dust.
Ingestion * Considered relatively harmless.
Mutagenicity No mutagenicity detected in Ames test.

* These statements are based on toxicological literature on the ingredients of this product and test results of similar
products.
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Safety data sheet Océ Cleaner A

continued on the next page
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The content of this safety data sheet is subject to the disclaimer on page 260 of 
this manual.
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Safety data sheet Océ OPC drum

continued on the next page

MATERIAL SAFETY DATA SHEET Number E-194-b-UK
(93/112/EEC and ISO 11014-1) Date July 1997

Page 1 of 2
Océ OPC Drum, Part No. 1989423

1. Product and company identification

Product name Océ OPC Drum, Part No. 1989423 (for Oc  9800)
Packing Plastic box

Company Océ (UK) Ltd.
Address Langston Road, Loughton, Essex IG10 3SL
Telephone 0181-508 5544 (contact product safety coordinator)
Telefax 0181-508 6689

2. Composition / information on ingredients

3. Hazards identification

To our knowledge this product presents no health hazard in normal use.

4. First aid measures

Eyes contact Not Applicable (=N.A.)
Skin contact N.A.
Inhalation N.A.
Ingestion N.A.

For any medical advice take along this material safety data sheet.

5. Fire fighting measures

Flash point (oC) N.A.
Explosion limits LEL N.A. UEL N.A.
Ignition temperature (oC) N.A.
Extinguishing media Dry chemical, carbon dioxide, water spray (fog), foam
Special fire fighting precautions N.A.
Hazardous products of decomposition N.A.

6. Accidental release measures

N.A.

7. Handling and storage

No special technical measures for storage.

8. Exposure controls / personal protection

No special technical measures. No personal protective equipment needed.
No special work hygiene practices needed.

Ingredients CAS No. ClassiÞcation Weight %

Aluminium 7429-90-5 >99
Resins < 1
Pigments < 1
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The content of this safety data sheet is subject to the disclaimer on page 260 of 
this manual.

MATERIAL SAFETY DATA SHEET Number E-194-b-UK
(93/112/EEC and ISO 11014-1) Date July 1997

Page 2 of 2
Océ OPC Drum, Part No. 1989423

9. Physical and chemical properties

Appearance and odour Brown odourless drum
Boiling point (oC) N.A Density (g/cm3) approx. 2,7
Vapour density (air = 1) N.A. Melting point (oC) N.A.
Solubility in water Insoluble Evaporation rate (butyl acetate =1) N.A.
Vapour pressure N.A. % Volatile 0
Other characteristics N.A. pH (solution) N.A.

10. Stability and reactivity

Thermal decomposition None at intended use
Hazardous decomposition products None at intended use
Hazardous reaction None at intended use

11. Toxicological information

12. Ecological information

This product is not biodegradable.
The ing redients are not classified as ecologically hazardous. No adverse environmental aspects are expected.

13. Disposal considerations

The drum will be returned to Oc  for re-use.

14. Transport information

This product is not classified as a dangerous substance according to the international transport regulations.

15. Regulatory information

This product is an article and contains no hazardous substances. Therefore, indications of special risks or safety advice on the packing are
not prescribed for this product.

16. Other information

Use: photoconductor for copiers.
Revision of E-194-a-UK dated February 1995.
Modification: none.

Copyright © 1995 Océ-Technologies B.V. Venlo, NL

Inhalation N.A.
Skin No adv erse health eff ects are e xpected.
Eyes N.A.
Ingestion N.A.
Mutagenicity No mutagenicity detected in Ames test. None of the ing redients is listed as m utagenic or carcinogenic.
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EPA ENERGY STAR®

Introduction  

Océ-Technologies B.V. has joined the ENERGY STAR® Program of the United 
States Environmental Protection Agency (EPA). The purpose of the ENERGY 
STAR® Program is to promote the manufacturing and marketing of 
energy-efficient equipment, thereby potentially reducing combustion-related 
pollution. Using the energy management features outlined below prevents 
unnecessary power consumption, which helps to prevent air pollution from 
electricity generating plants and saves money on your utility bills.

As an ENERGY STAR® Partner, Océ-Technologies B.V. has determined that the 
below-mentioned configurations of the Océ TDS800 meet the ENERGY 
STAR® guidelines for energy efficiency:
■ Océ TDS800 Printer, consisting of printer, controller and monitor.
■ Océ TDS800 Scanner.

The Océ TDS800 Multifunctional Digital System, consisting of Océ TDS800 
Scanner and Océ TDS800 Printer including controller and monitor, has the 
same efficiency features but does not meet the ENERGY STAR® specification 
for the sleep mode of a multifunctional device.

Features  

The ENERGY STAR® Criteria involve following features.

■ low power mode
The Océ TDS800 Printer, TDS800 Scanner and TDS800 Multifunctional 
Digital System enter automatically the low power mode 15 minutes after 
completion of the last job. The Key Operator can adjust the low power mode 
default time between 15 and 240 minutes.

■ sleep mode
The Océ TDS800 Printer and TDS800 Multifunctional Digital System enter 
automatically the sleep mode 90 minutes after completion of the last job. The 
Key Operator can adjust the sleep mode default time between 15 and 240 
minutes.

During the sleep mode of the Océ TDS800 the controller remains in operation.

It is suggested to determine the appropriate default times for your work pattern 
by changing the setting in steps of 30 minutes and testing each setting for at 
least a week.
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Only if this limit of 240 minutes still causes sizable inconvenience, due to your 
particular work pattern, the key operator can disable the sleep mode. 

Power consumption data  

The controller in below-mentioned products is a functionally integrated 
computer.

Note: (1) Without controller, as defined for Tier 1 in the Printer/Fax MOU 
Version 3.0.

Note: (2) MDS = Multifunctional Digital System, consisting of printer, scanner, 
controller and monitor.

ENERGY STAR® is a U.S. registered mark.

Power data
Low Power mode
(Watts)

Low Power 
recovery time 
(seconds)

Sleep Mode
(Watts)

Océ TDS800 Printer 493 35  13 (1)

Océ TDS800 Scanner 7 N.A. N.A.

Océ TDS800 MDS (2) 752 35 115
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Notation conventions

There are a number of notation conventions used in this manual. This 
consistent style enables you to quickly become conversant with the use of this 
manual and consequently the Océ TDS800.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered sequentially 
throughout this manual. Figures include pictures of product components, 
screenshots, examples, and diagrams of concepts discussed in the description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters that ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to prevent 
something (your copy or original, the copier or printer, data files etc.) from 
being damaged.

Caution: The information that follows ‘Caution’ is given to prevent you 
from suffering personal injury. 



273

Reader's comment sheet

Have you found this manual to be accurate?
❏ Yes
❏ No

Could you operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide enough background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, readability and arrangement 
(page layout, chapter order, etc.)?
❏ Yes
❏ No

Could you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

What did you use to find the required information?
❏ Table of contents
❏ Index

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual. 
If you have other comments or concerns, please explain or suggest 
improvements on the back of this sheet or on a separate sheet.



274 Océ TDS800 User Manual

Comments:

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------
Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
For the attention of ITC User Documentation.
P.O. Box 101,
5900 MA Venlo
The Netherlands

Send comments by E-mail to : itc-userdoc@oce.nl

For the addresses of local Océ organizations, see: www.oce.com
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Addresses of Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
No. 138 Wan Fu Jong Dajie
T1-719 Sun Dong An Plaza
Beijing 100006
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Vallensbaekvej 45
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
45414 Mülheim an der Ruhr 
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV 's-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495-139 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 754
S-191 27 Sollentuna
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 606556
U.S.A.
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Index

A
account center 171
account console 175
account logging 61
account logic 173
adobe postscript 3 /pdf 15, 22
applications

queue manager 20
settings editor 21
system control panel 21

arrow keys 48
auto align 106
auto roll 46
automatic logon 165
available material types and sizes 253

B
background compensation 104
belt unit 178, 183, 185

side guides 185
binding strip 180
brightness 103

C
cancel a print job 39
checkprint 75
chip tray 188, 193
clear the system 145
command line parameters 166
connect to a controller 169
continue a print job 39
controller

start up 24
copy jobs 55

define settings 61
next original 61
non-standard size originals 98

special originals 98
copy size 99
cut & paste 105

D
define file names 86
delete a destination 85
delete a scanned file 87
delete print jobs 153
destination card 74
drawing method 179

E
editing an image 106
exposure 46, 56

F
folded package length 180
folded package width 179
folder

belt unit 178, 183
folding settings 179
punch unit 178
reinforcement unit 178

folding 50, 56
folding length

maximum 182
folding method 179
folding settings 179, 182
ftp 90

printing 17
retrieve files 90

function keys 48

G
green key principle 16
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H
history queue 149

I
inbox queue 149
install remote logic 157

apple macintosh 161
microsoft windows 157
unix 159

interrupt a job 63

J
jams 217
japan support

destination names 84
fonts 15, 22

job interrupt 47, 54, 63
job recovery 16
job templates

define the default settings 137
description 52

K
key operator settings 127

L
load a roll 191
load paper 188
load rolls of media 188
lock a destination 84
log off 164
log on 164

M
manage print jobs 153

manual feed 46
copy jobs 62

manual feed 62
matrix logic 112
media display 143
media selection 46, 56
mirror-image 109
move a job to top 154

N
non-standard size 98
non-standard sized originals 98

O
océ account center 171
océ account console 175
océ account logic 173
océ matrix logic 112
océ print exec workgroup 40
océ remote logic 155
océ repro desk 42
original type 105

P
paper jam 217

high capacity output unit of the folder 231
manual feed 218

paper series 55, 57, 192
password 165
pdf 15, 22, 76

compression 77
print a scanned file 87
print exec workgroup 40
print queue 149, 153
print with oce print exec workgroup 40
print with oce repro desk 42
printer 14, 29

counter 34
graphical display 33
keys 34

on-line 35
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selection keys 35
stop 35, 63
up / down keys 35

media selection 192
operator panel 32
select a language 32
setting media types and sizes 36

printer operator panel actions 36
printer settings

media types and sizes 36
setting a special media indication 36

printer status display 143
problems

original jam 214
other 214, 240
paper jam 214
reinforcement unit 214

product specifications 245
properties of a scanned file 88
punch unit 178, 186

Q
queue manager

active print job window 148
delete print jobs 153
function 148
functionality 20
history queue 149
inbox queue 149
introduction 20
menu bar 148
move a job to top 154
pause print jobs 154
print queue 149
put print jobs on hold 154
remote workstation 148
restart jobs that are put on hold 154
restart paused print job 154
structure 148
user modes 151
view print queue 153
window 150

R
reference roller 206
reinforcement unit 178, 183

insert a new tape roll 196
maintenance 208
problems 234
waste box 208

remote logic
add a controller 169
applications 156
command line parameters 166
connect to a controller 169
help 166
how to use 169
language 166

repro desk 42
repro operator settings 127
restart a paused print job 154
restart jobs that are put on hold 154
retrieve scanned files 89

ftp 90
roll holder 188, 191
roll loader 191

S
safety data sheets 260
safety information 258
scan clicks 71
scan jobs

filing strip 100
image quality 103
leading and trailing strip 101

scan logic 70
scan manager 79

delete a destination 85
destination 80

lock 84
unlock 85

destination properties 85
file properties 81
local destination 82

retrieve files via ftp 90
network destination 83
table view 81
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temporary store 89
tree view 80
web destination 84

scan width 98
scanned files 87
scanner

display
image card 104
original section 104

exposure control 46
input mode 58
keys

auto roll 46
correction key 47
job interrupt 47
manual feed 46
numeric keys 47
start key 47
stop key 47

media selection 55
mirror an image 78
numeric display 47
operating panel 45
operator panel

change language 52
destination card 74
file section 75
image card 74
sections 49

reference roller
clean 206

zoom 60
scanner

keys
media selection 46

scanner status display 143
scan-to-file 70, 72

destination 72, 75
ftp 84
local 82
smb 83

enable 70
file format 76

cals 76
pdf 76
tiff 76

file properties 81
local destination

retrieve files via ftp 90
optimisation 78

file size 78
scan quality 78

resolution 77
settings 74
zoom 78

section keys 48
set copy 58, 111
set memory meter 143
setting dependencies 127
settings

scanner operator panel 53
settings editor

access the settings editor 135
apply 130
menu bar 129
settings area 131
status bar 132
tree structure 131
undo 130
update area 131

shift the image 108
special media indication 38
spool memory 16
stamping 65
standard cut 107
start key 56, 111
stop a copy job 63
stop a print job 39

stop key 39
synchro cut 107
system administrator settings 127
system control panel 142

icons 144
structure 142

T
templates 53

define the default settings 137
description 52

temporary store 89
tiff subformat 76

compression 76
organization 76

timers 25, 133
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toner 194
add 194

turn on and off 23

U
unlock a destination 85
user interaction 16
user modes 135, 163
users 18

anonymous user 18
key operator 18, 21
repro operator 18
service operator 18
system administrator 18, 21

V
view a scanned file 87

automatically 89
view station lt 70, 92

view a scanned file 73
view error 95

W
warm up 24
waste box 208
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